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1  Introduction
The primary part number for the Compumedics CURRY product is 9138-0050-01. 
CURRY 8.0.6 is an update for CURRY 8.0. It contains bug fixes, improved file format 
support, and feature additions.

CURRY 8 software suite comprises the following programs:

• CURRY 8

• CURRY 8 Launcher

• Dongle Updater

2  Changes in CURRY 8.0.6 from CURRY 8.0.5

2.1  Highlights
• Acquisition now writes a parameter file as backup (extension .dpo).

• Added CURRY Express (E)-support for MultiGrael and MultiGrael EEG amplifiers.

• Added support for Micromed files with high sampling rate (up to 16,384 Hz).

• Improved heuristics for determing Auto Line Width.

• Waveboard display added to event-list options for BPM (e.g. heart-rate) over 
time.

• Support for GE Signa 5.x archive image data file format.

• Support for compressed GE image data file formats.

• 3D View plane offset for double and triple cutplanes now only affects axial plane.

• Improved usability of frequency domain statistics.

• If Localize locations have an individual color assigned, that color remains visible 
in the Image Data views even when locations are selected.

• Visibility of 3D View objects that are associated with a file, such as surfaces, 
points, BEMs, FEMs can now be saved to and retrieved from study parameters.

• A report template for epilepsy evaluations is now available in the install folder.
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2.2  Enhancements

2.2.1  User Interface
• When modifying number fields with the arrow keys, the cursor up/down keys, or 

the mouse wheel, the increment is reduced by a factor of 5 if the <Shift> or the 
<Alt> key is pressed (only <Alt> works with mouse wheel).

• Option to enforce a line width of 1 for all views that are in auto line width mode via
Edit > Options > User Interface.

• Maximized data display views can now be restored by pressing the <Esc> key.

2.2.2  Database
• Extended format to store "auto-run" information in studies, not in files

• Ask before executing a macro from the database via double-click or context 
menu.

2.2.3  Acquisition
• Network amplifiers are searched for a little longer now, to decrease the possibility 

of missing one.

• Path and name of recorded files are now always written to log file.

• Improved speed and accuracy of HPI coil fit in Orion MEG recordings.

• “Show All Channels” now automatically resets Max Displ. Channels in all views.

• Show warning about minimum TTL pulse width when lowering sampling rate on 
Grael V2 device configurations.

• In-built device configurations are now sorted by cap type.

• NetStreaming protocol (version 803) now allows client to specify the recording 
path.

• Split File can now also be used while a recording is paused.

• Acquisition now writes a parameter file as backup (extension .dpo).
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• NuAmps impedance computation now estimates the Gnd electrode impedance 
value 10% higher than before, which slightly lowers overall impedance values.

• Amplifier now tries to automatically re-connect when it gets detected that data has
stopped coming in.

• In Auto line width mode, limit cursor line width to waveform line width plus 1.

• Allow digitization of Ref sensor in Orion MEG/EEG recordings.

• Added support for MultiGrael and MultiGrael EEG to CURRY Express.

2.2.4  EEG and MEG Data Import
• Added support for Micromed files with higher sampling rate (up to 16,384 Hz).

• Removed restriction that EDF+ "annotations" must be in the last channel of the 
file.

• Neuromag data that has not been “Smartshield filtered” is not rejected any more.

• CTF reader now supports “blocked” data spanning over multiple files.

2.2.5  Signal Processing
• Improved autoscaling of EEG-waveforms (removed default for EEG)

• Improved handling of time-frequency plotting to prevent potential issues with 
montages, global-dissimilarity or with groups where all channels are deselected.

• “Median” HPI head movement correction now disregards HPI positions within Bad
Blocks.

• Added option “Median” to HPI head movement correction options.

• Add HPI and head movement correction information to Show Infomation dialog 
and file history.

• Changed option “Move Cursor by Samples” to “Move Cursor by Pixels”.

• In Auto line width mode, line width in butterfly plot mode now depends on number
of channels shown.

• In Auto line width mode, limit cursor line width to waveform line width plus 1.

• Default event voltage thresholds changed to +/- 50 µV.
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• Latencies always given in seconds.

• Improved performance by faster matrix multiplication routines.

• Added inserting events from epoch-info of single files.

• Improved parameter file storage of template matching modes where channels are
automatically selected.

• Removed “store in database” options when exporting audio files (extension wav).

• Increased the maximum number of ticks per page from 10 to 20.

• Increased the allowed range of event pre- and post-latencies from 100s to half-
pagesize.

• Avoid source reconstruction from averaged exported amplitude spectra.

• Display filename for epochs from concatenated files with back-to-back epochs.

• Increased number of digits for noise and SNR threshold criteria.

2.2.6  Maps / 2D View
• In sLORETA case, use correct units for CDR waveforms.

• In Auto line width mode, line width now adapts to view layout.

• Improved detection of sEEG electrodes to avoid false detection of scalp EEG 
electrodes with outliers. 

• Enabled map projection for sEEG data.

• Improved saving of shifted positions and scaling of waveforms in position plot to 
study parameters.

• Improved auto-scaling of contour-line plots for PCA/ICA and MGFP maps.

2.2.7  Image Data Import
• Reduced detection threshold for tilted slices to account for rounding errors.

• DICOM autodetection support for Patient Age given in weeks.

• DICOM autodetection support for Patient Sex type “Other”.

• For GE image data, avoid mixup of series numbers from different patients.
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• Extract protocol name from GE image data.

• Support for GE Signa 5.x archive file format.

• Support for compressed GE image data.

• Improved handling of .nii.gz and .mgz files in database und recent file list.

• New “Ignore slice duplicates” option for ignoring duplicate slices with identical 
image number within a DICOM series.

• Intensity autodetection mode is now saved to image data parameter files.

• Intensity autodetection mode is now restored after loading image data, if not 
already present in image data parameter file.

• After changing an existing bias field correction, a popup question appears and 
threshold autodetection can be initiated.

• Ignoring slice distance as a hint for calculating the zoom factor, if slice distance is 
much larger than the pixel size.

• Improved criteria for detecting and ignoring DICOM files without image data.

• If .nii.gz or .mgz files are loaded, .nii or .mgh files that Curry temporarily creates 
are now deleted even if recovering from a crash.

• Unzipped versions of gzipped image data files for temporary use are now 
deleted, not moved to the recycle bin when closing the study. 

• Support for DICOM folders with individual scaling per slice.

2.2.8  Image Data
• When saving RGB DICOM images, the (0008,0016) SOP Class UID tag is now 

set to 1.2.840.10008.5.1.4.1.1.7.4 (Multiframe True Color Secondary Capture 
Image Storage) and the (0028,0006) Planar Configuration tag is set to 0.

• When saving DICOM images, for Patient Age, month, week, and day notations 
are now also supported.

• When saving DICOM images, Patient ID, Accession, Magnetic Field Strength 
fields now remain empty if unknown or anonymized (Patient ID only).

• When saving DICOM images, Referring Physician field now remains empty.
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• When loading CT data with a wide range of values, the color lookup tables for 
Orthogonal and MIP views are preset to show just the range from -1024 to 3072. 

• Improved output log if JPEG 2000 image decoding fails (for example, signed 
JPEG 2000 images are not supported).

• When changing segmentation thresholds using the mouse wheel in the 
Segmentation Preview or Segmentation Result views, the <Alt> modifier for 
changing the upper threshold now also works for the sliders on the left. 

• Improved scale display in Orthogonal Views.

• Improved visibility of oblique cutplane indicators around crosshair cursor in the 
other orthogonal views.

2.2.9  Source Analysis
• Improved internal handling of subtraction dipole model for FEM in order to 

prevent potential memory leak.

• Include epoch name and number in source results description.

2.2.10  3D View
• If Functional Landmarks are displayed and a headshape is available, it is now 

automatically shown, but can be switched off in Functional Landmarks Properties.

• Plane offset for double and triple cutplanes now only affects axial plane.

• Improved layout of coherence arc table shown in Output area if Verbosity is high.

• Global ellipsoid and trace mode changes via the pop-up quick access buttons 
now also apply to objects not currently visible.

2.2.11  Localize
• When choosing one of the menu options to import source results into Localize 

and the <Ctrl> key is pressed and Localize is not in Append mode and no macro 
is running, a popup dialog will appear and ask if the locations shall be appended 
to or replace current Localize locations.

• Change Locations now observes re-slicing of Segmentation Preview and 
Segmentation Result views.
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• When updating Grid Geometry labels and no Localize entry is selected but 
Localize list contains more than than one electrode, ask whether to update first or
last electrode.

• When adding dipole results to Localize, detect if there are less unique locations 
than samples and offer to import unique locations only.

• Display selected Localize locations surrounded by highlight color, with original 
color still visible, only if locations don’t have the default color.

• In Segmentation Result, selected Localize locations can now be displayed 
surrounded by highlight color, with original color still visible.

• In Segmentation Result, all contacts of an electrode are now highlighted while 
dragging.

2.2.12  Results
• When averaging CDRs in Statistics, correct (instead of generic µAmm) units are 

now used.

• When working with spectral data, in the Statistics Latency Ranges section, [ms] 
values are now interpreted as [Hz], and samples as frequency bins.

• More detailed Statistics results output for single-sample and frequency domain 
cases.

• Statistics results output now includes number of randomizations used.

• When exporting Statistics results to Excel, sensor data are now exported as well.

• When calculating averages in Statistics, within-Subject comparisons, if activated, 
are now ignored and the corresponding dropdown is grayed out.

• Excel export of Source Results in frequency domain now includes frequency-
specific labels and [Hz] as the unit.

• Excel export of Statistics results now includes units in column headers.

• If multiple items in the result tree are selected, editing of names and descriptions 
is now disabled.
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2.2.13  Digitizer
• When digitizing sensors in a user-defined order, positions in .pom file export are 

now sorted by the channel order of the amplifier, instead of the user-defined 
order.

• Numbers that have two digits or more and are contained within labels are now no 
longer spelled out, but pronounced as a whole.

• Added option to compare current digitizer result to a template and plot results to 
Output.

• Digitizer channel order of amplifier configuration is now also considered when 
digitizer get initialized from a running Acquisition.

2.2.14  Miscellaneous
• Improved detection of depth/grid/strip electrodes for FEM modeling and oblique 

Image Data views. If there is more than one EEG channel group, all sensors 
within a group are now assumed to be of the same type. 

• A warning now appears for file names longer than 255 characters in order to 
avoid unexpected behavior.

• Improved Matlab script to load Curry data so that channel labels can be read 
when having .dpo parameter files.  

• Visibility of 3D View objects that are associated with a file, such as surfaces, 
points, BEMs, FEMs can now be saved to and retrieved from study parameters.

• Windows screen scaling now limits auto line width.

• If credentials verification method is “Local Curry” but no users have been defined,
a warning is shown when closing Edit > Options and user logon is denied.

• Improved behavior in situations where <Esc> key is pressed while no 
computations are running.

• Password field is now cleared after an unsuccessful logon attempt.

• Curry now closes after five unsuccessful attempts to enter password.

• Answers to popup questions recorded in a macro are now more easily 
attributable.
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• For popup questions with cancellation option and more than two other choices, 
the Cancel option can now be the default choice.

• Improved initial folder handling for File > Open dialog, depending on file type 
selected.

• A report template for epilepsy evaluations is now available in the install folder.

• Waveboard display added to event-list options for BPM (e.g. heart-rate) over 
time.

• The “core” feature of the Curry license is not needed any more.

• The text-to-speech feature (mainly used in the Digitizer module) now tries to 
specifically use a voice in UK or US English, if installed.

2.3  Issues Addressed

2.3.1  User Interface
• Fixed an issue where Output window contents were sometimes not up-to-date.

• Fixed an issue where Workflow items do not update after removing / re-adding 
Functional Data’s sequence UI elements.

2.3.2  Database
• Fixed a bug where source results could not be loaded via right-click.

• Fixed an issue that prevented reading some legacy Curry 6 databases correctly.

• Fixed a bug that prevented displaying “recording” icon for unfiled studies.

• Fixed a bug that displayed directories beginning with a dot as "missing".

• Fixed a bug that prevented adding files to a group study when exporting data.

• Fixed a bug in MDA export that may led to duplicate default studies.

• Fixed a bug that auto-detected result files as digitizer files.
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2.3.3  Acquisition
• Fixed an issue when converting recordings, where the converted file contained a 

double sample around every 10 MB.

• Fixed an issue where the Sparse Montage option was not re-set when switching 
views.

• Fixed an issue where a network amplifier name was not fully displayed if it was 
longer than 20 characters.

• Fixed an issue where the amplifier selector could show the wrong amplifier after 
connecting to a network amplifier.

• Fixed an issue when an amplifier could run into a timeout when the user did not 
respond to question about re-using digitized positions in time.

• Fixed an issue where selecting an option from a View context menu could be 
applied to a neighboring view.

• Fixed an issue where the video file was not correctly split when using an RTSP 
camera and reconnecting the amplifier within the same study.

• Added an option in Edit > Options to work around occasional system crashes of 
some computers when stopping an impedance check on a Synamps amplifier.

• Fixed an issue where, when additionally saving processed data, data was not 
saved to disk when artifact detection was enabled.

• Fixed an issue in the digitization order of the default QuikCap 128 Net amplifier 
configurations.

• Fixed an issue where running an impedance check on Synamps 2/RT devices 
with multiple headboxes in AC mode could lock the amplifier.

• Fixed an issue where the impedance view got enabled when the user canceled 
starting an impedance check in MEG/EEG acquisitions.

• Fixed an issue where the start time of an RTSP video could be zero when 
performing more than one acquisition within the same study.

• Fixed an issue where files required for RTSP video streaming were not installed 
on 64 bit systems when performing a fresh Curry installation.
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2.3.4  EEG and MEG Data Import
• Fixed a bug where epoched CTF files were displayed as continuous data.

• Fixed a bug that appended "empty" electrodes when loading external digitizer 
files (MEG + EEG configuration only).

• Fixed a bug that prevented Functional Data Parameters to show up correctly 
when loading studies with concatenated files (Acquisition without Digitizer support
only).

• Fixed a bug in displaying Talairach coordinates.

• Fixed a bug that prevented autodetection of XLTek format when choosing file with
EEG extension.

• Fixed a bug in EDF import that computed wrong sampling rate when annotation 
channel has more "samples" than the rest of the signals.

• Fixed a bug that shifted Neuromag events after applying (external) TSSS filter.

• Fixed a bug that prevented importing MAP and DIP files as Functional Data.

• Fixed defining column types in Raw Digitizer File Import.

• Fixed dysfunctional "Help" button in Raw Digitizer File Import.

• Fixed a crash when writing "empty" headshape points (combined MEG / EEG 
only).

• Fixed a potential issue that led to the duplicate insertion of anatomical localization
files.

2.3.5  Signal Processing
• Fixed saving spectra of epoched data from event list

• Fixed a bug when exporting more (back-to-back) epochs than originally 
loaded/concatenated.

• Fixed a crash when exporting back-to-back epochs from a concatenated epochs 
file.

• Fixed a bug where the event for the beginning of a video recording was not 
placed at the correct time point.

Doc 6509 Rev G Page 17 of 94



COMPUMEDICS USA, INC.
Title: CURRY 8.0.6 Release Notes
Document Number: 6509 Revision: G
Revised By: JK Rev Date: 11/16/20
Written By: MXW Original Release: 07/20/16
Procedure Format 3090 Rev F

• Fixed a bug with time-frequency plots of individual channels shown 
simultaneously with auto-scale off, so that scaling is done group-wise. 

• Fixed a bug where a multi-channel selection via Ctrl+Click could select the wrong 
channels.

• Fixed a bug in the display of the time-range of templates.

• Fixed a bug when changing the template channel after initial selection.

• Fixed a bug in displaying the start-time of concatenated data.

• Fixed a bug where manually loading a parameter file containing changes in 
processing chain panels could lead to disappearing events.

• Fixed a bug where incorrect statistics results backdrop were shown for large 
numbers of samples and small Maps view widths.

• Fixed a bug where not white but gray backdrop areas accumulated for 
consistency test and PCA/ICA butterfly plots.

• Fixed a bug that saved only the first section of up-sampled data.

• Fixed a bug that exported head-shape positions twice.

• New beta-features for MEG interference reduction: SSP (SignalSpaceProjection) 
to project empty room components from MEG-data (and lead-fields in forward 
computations) and DSSP (DualSignalSubspaceProjection)

• Fixed export of hypnogram events from an unsorted event-list.

• Fixed a potential crash when displaying waveboards on multiple montitors.

• Fixed linear artifact reduction with previous All and Global selection.

2.3.6  Maps / 2D View
• Fixed the display of the actual timepoint in a maps movie.

• Fixed a bug where, if a single sample was selected, channel tooltips were not 
displayed in the Maps/Waveforms view.

• Fixed a bug that kept a file “locked” after exporting data.

• Removed dysfunctional database options from “Save as wave file” dialog
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2.3.7  Image Data Import
• Fixed a bug where for GE-format images an incorrect tilt angle was calculated.

• Fixed a bug where bias field correction was incorrectly switched off, if image data 
parameters were opened before image data had been loaded and displayed.

• Fixed a bug where series UIDs read from ACR-NEMA or DICOM headers were 
not trimmed for trailing whitespace, possibly resulting in an error message when 
trying to re-load already parameterized image data.

• Fixed a bug where, if “Shortcut” is checked, image data offset is not auto-
detected.

2.3.8  Image Data
• Fixed a bug where image data intensities could change after canceling out of 

Image Data Parameters.

• Fixed a bug where in some cases image data were re-loaded after an unrelated 
change in database study files.

• Fixed a bug where the oblique view rotation indicator locations in Grid view are 
wrong.

• Fixed a bug where a rare error message during ellipsoid cut-plane calculation 
could block Curry.

• Fixed a bug where, for BEM Geometry setup, “include electrode locations” had no
effect.

• Fixed a bug where, for CT data, “Create Brain Mask” and “Create Intracranial 
Electrode Mesh” sometimes produced sub-optimal results.

2.3.9  Source Analysis
• Fixed a bug in the FEM engine which could lead to a crash when performing a 

FEM setup in 64-bit.

• Fixed a potential bug in the preprocessing of intracranial and mixed FEMs which 
could prevent them from being used in source analysis.

2.3.10  3D View
• Fixed a crash when displaying landmarks using Shape “Vector”.
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• Fixed a bug that displayed multiple (non-regional) dipoles in wrong symbol sizes 
(movie mode only).

• Removed duplicate entries from “Text Size” UI (“Coordinates” and “Distance”).

2.3.11  Localize
• Fixed a bug where “Save and Use as Digitizer file” failed if multiple EEG channel 

groups existed and some were deselected. 

• Fixed a bug where “Save and Use as Digitizer file” failed if MEG channel groups 
existed. 

• Fixed a bug where deleting a row via keyboard could not properly be undone.

• Fixed a bug where Curry crashed if localize labels (excluding a trailing number) 
are longer than 40 characters.

• Fixed a bug where, if a grid label already existed and a suggested label was 
used, label numbering started with “1” instead of “01”.

2.3.12  Results
• Fixed a bug where a “Load All” entry would appear in the statistics context menus

in the Results panel. 

• Fixed a bug where the wrong start frequency appeared in Statistics results when 
using a start sample different from zero in Latency Ranges

• Fixed a crash when averaging CDR results with more than one sample.

• Fixed a bug where Excel export of statistics results calculated in the frequency 
domain contained wrong frequency values in column one.

• Fixed a possible crash when using Project to in the Statistics Data Options and 
results had been calculated on a surface.

• Fixed a bug where, when calculating averages in Statistics and within-Subject 
comparisons were activated, only partial averages were saved and file overwrite 
requests were issued.

• Fixed a possible crash when loading an empty or corrupted file.

• Fixed a possible crash when analyzing a single sample in statistics.
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2.3.13  Digitizer
• Fixed a bug where positions loaded from a pom file where overwritten again on 

pressing Stop Digitizer.

• Fixed a bug where not all positions were saved to a pom file when Interpolation 
was used and the Save button was pressed after Digitization was already 
stopped. 

• Fixed a bug where the user interface is not visible after closing and re-opening a 
study.

2.3.14  Miscellaneous
• Fixed a bug where mouse cursor arrows hinting at macro playback/pause/record 

states had a black background if a color cursor was selected in Windows 
Settings.

• Fixed an issue where Curry could crash when started without any configuration 
files in place.

• Fixed a bug where, for popup questions with cancellation option, “Don’t ask 
again” also applied to the Cancel button.

• Fixed a bug where, after pressing the Delete button in Options > Logon, the 
deletion confirmation popup reports a wrong or no username.

• Fixed an issue where Curry could crash when running on a CPU with more than 
32 cores.

• Fixed an issue where the Video window could partially overlap with the video 
control buttons when the Windows Screen Scaling was set to values larger than 
100%.

• Fixed a bug that displayed incorrect study labels when using Macro "Loop over 
studies".

• Fixed a bug where Macro "Loop over studies" reported wrong study number 
counts, if no files were inserted on the Group or Subject level.

• Fixed a bug in text importer that sometimes led to incomplete UTF-8 conversion.
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3  Changes in CURRY 8.0.5 from CURRY 8.0.4

3.1  Highlights
• Added support for multi-user access to CDB databases (first user to connect has 

full access, all subsequent users have read-only access).

• Added support for Event Button on Grael amplifiers.

• Added support for Network Photic Stimulator.

• Linear interpolation added as new Artifact Reduction method. 

• When using a montage with gaps, selecting a color scale now colors each block 
separated by a gap in an individual color.

• When using the shortcut in Image Data Parameters for the first image data set, a 
reminder pops up that allows to define landmarks.

• When using the shortcut in Image Data Parameters for the second (or greater) 
image data set, landmarks are now auto-detected via co-registration with first 
image data set.

• Support for tilted image data slices. This can occur if the CT gantry is tilted.

• Added FEM Mixed to list of available models for creation in BEM/FEM Geometry.

• Selected Localize locations are now surrounded by highlight color, with original 
color still visible.

• Option to adapt any depth, strip, and grid electrodes in the Localize list. 

• Grid geometry labels can now be entered as plain text. In this case, numbering is 
automatic.

• Montage Editor: Added option to Unravel overlapping symbols in electrode 
placement. Auto-created electrode placements are automatically unraveled.

• Password protection option: logon credentials can be verified against local Curry 
user database, local Windows users, or domain server.

• Added support for Orion LifeSpan MEG device.
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3.2  Enhancements

3.2.1  User Interface
• Functional Data Parameters/Import/Wizard have been renamed to Functional 

Data Parameters.

• Image Data Parameters/Import/Wizard have been renamed to Image Data 
Parameters.

• When Curry functionality tries to expand a parameter panel but that panel is 
already expanded, other panels do not automatically close any more.

• The Functional Data Events/Epochs panel now remains open when opening the 
Threshold Criteria panel.

• The Functional Data Events/Epochs panel does not have a Manual checkbox any
more; pressing number keys inserts manual events at the cursor position.

• The Functional Data Events/Epochs – Export Events dialog has a Cancel button if
‘All’ or ‘Multiple’ is selected as event type.

• The 3D View Objects panel now remains open when opening the Options panel.

• The available 3D View shapes are now sorted alphabetically.

• Improved layout for Save Image Data Options dialog.

• In the Edit menu, Pause Fit is only enabled if source analysis is feasible.

• The width of the Functional Data window’s navigation area now scales with the 
screen DPI.

• Seldom used parameter dialogs like “HPI coils” are hidden programmatically 
when they are not in use.

• Adding image data to an Acquisiton study will leave the Acquision views 
accessible.

3.2.2  Database
• Removed dependency for "Access database engine" in 64-bit mode.
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• Added support for multi-user access to CDB databases (first user to connect has 
full access, all subsequent users have read-only access).

• Added “DICOM Study Number” for studies.

• Added “other” gender.

3.2.3  Acquisition
• Added support for Orion LifeSpan MEG device.

• Added support for Event Button on Grael amplifiers.

• Added an option to display frequency data using a log scale along the x-axis.

• Added option to be reminded of performing an impedance test after a definable 
time has passed.

• Split View parameter is now saved in parameter file.

• New RTSP Network Camera option (also works for all new Vivotek cameras).

• PTZ control of Vivotek cameras is now done continuously instead of in steps.

• Default displayed frequency range when turning on Spectra is now 0-100 Hz.

• Added option to Average Conditions to only average epochs with an even or odd 
index.

• Improved performance when receiving hundreds of events in a short period of 
time.

• Added support for Compumedics Network Photic Stimulator (P/N 8022-0063-01).

• Default Grael V2 and Grael V2 EEG configurations now use a sampling rate of 
2048 Hz to allow the trigger module to register short TTL pulses.

• MATLAB NetStreaming example supports “stop amplifier” functionality.

• Neuvo: OxStatus and HR channel values are now displayed as they are and no 
longer unnecessarily converted to uV.

• The Time/Frequency plot now displays a faded cursor.

• When recording processed data, events stored for the processed data file can be 
aligned to StimTracker events.

Doc 6509 Rev G Page 24 of 94



COMPUMEDICS USA, INC.
Title: CURRY 8.0.6 Release Notes
Document Number: 6509 Revision: G
Revised By: JK Rev Date: 11/16/20
Written By: MXW Original Release: 07/20/16
Procedure Format 3090 Rev F

• Setting for online spectra are now kept when dis- and re-connecting an amplifier 
within the same study.

• Option to “Select All Channels” added to acquisition waveform view context 
menu.

3.2.4  EEG and MEG Data Import
• The following channel labels are now additionally assumed to be “Other” 

channels: EtCO2, CO2Wave, Z, E, BN, AV, SD, RFU1..6, Aav, 0V, Mark1, Mark2, 
COM, AVG, DC13..28, $SP1..4, 

• The following channel labels are now additionally assumed to be “EEG” channels:
BN1, BN2, EX.. 

• The BrainVision event reader now creates types from “annotations”, if both 
“annotations” and “types” are available. This behavior is governed by the 
parameter UseBrainvisionAnnotationsForTypes in the SessionDefaults.cfg file

• The Nihon Kohden reader now supports segmented data files.

• A scaling factor can be applied when parsing trigger channel(s).

•  Raw text importer can now handle multiple epochs in "multiplex" mode.

3.2.5  Signal Processing
• Added options to adjust for head movements in recordings from Orion LifeSpan 

MEG with Head Position Indicator data.

• Added two reorder montages for Orion LifeSpan MEG recordings.

• Contour lines in monochrome mode are now drawn with dashed line styles. 

• When jumping to the first epoch and a macro is running, the macro loop counter 
is now initialized to the number of epochs. 

• For time resolved spectra of epoched data with ‘Use All’ selected, the spectrum of
the first epoch is displayed.

• The Waveform display has an improved collision detection for filename/time and 
event labels shown in the upper left and right corner to avoid overlapping strings.

Doc 6509 Rev G Page 25 of 94



COMPUMEDICS USA, INC.
Title: CURRY 8.0.6 Release Notes
Document Number: 6509 Revision: G
Revised By: JK Rev Date: 11/16/20
Written By: MXW Original Release: 07/20/16
Procedure Format 3090 Rev F

• Improved automated detection of sEEG by fitting spheres to each group 
separately.

• Waveform display now automatically consolidates multiple consecutive gaps in 
montages.

• Linear interpolation added as new Artifact Reduction method. 

• For studies that contain video, the event scrollbar shows blue bars for time 
ranges where video is available.

• In epilepsy scope, manually inserted events 6,7,8 now have "Spike 6,7,8" as their
annotations.

• When using a montage with gaps on one group, selecting a color scale now 
colors each block separated by a gap in an individual color.

• Added option to use left/right arrow keys to either move cursor by sample or by 
pixel.

• When using the left/right keys on the keyboard to move time cursors, the cursors 
now move by one pixel or one sample, depending on how dense the data is 
currently plotted to the screen.

• When leaving in-place average mode, only disable source reconstruction if it was 
not already active when in-place averaging started.

• Option to zoom in even if no time range is selected (zoom to +/-10% of current 
page).

• Option to filter events by their annotation using ‘is’, ‘is not’, ‘contains’ and ‘does 
not contain’.

• Filtering events by annotation supports shortcut expansion.

• Files with hypnogram events of multiple subjects are now plotted in separate bars
above the horizontal scroll bar.

3.2.6  Image Data Import
• Improved auto-detection of 3D DICOM files.

• Allow for negative numbers in DICOM SliceSpacing tag (use absolute value as 
slice distance).
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• When an unparameterized image data set is added to the current study, its Image
Data Parameter window now opens immediately.

• When using the shortcut in Image Data Parameters for the first image data set, a 
reminder pops up that allows to define landmarks.

• When using the shortcut in Image Data Parameters for the second (or greater) 
image data set, landmarks are now auto-detected via co-registration with first 
image data set.

• Support for tilted image data slices. This can occur if the CT gantry is tilted.

3.2.7  Image Data
• Points are not displayed if their number is large and their distance is small.

• Added FEM Mixed to list of available models for creation in BEM/FEM Geometry.

• Midsagittal landmark may now be placed inferior to AC-PC line, however, such 
placement is not recommended in case of brain anatomy asymmetries.

• Updated ITK engine for bias correction to version 5.0, improving performance.

• Display selected Localize locations surrounded by highlight color, with original 
color still visible.

• Use thicker lines when plotting results on high-dpi screens.

• Improved discrimination of strip vs depth electrodes for oblique view angulation.

• Electrodes, Localize locations and Points are now visible even if covered by CDR 
or Scan results.

• Support for loading second Freesurfer triangle mesh hemisphere even when 
color intensities have been added. 

• When loading Freesurfer triangle mesh files, parcellation files such as 
lh/rh.aparc.annot can now be used for coloring

• Oblique slices in automatic or orthogonal mode are now adjusted based on 
electrodes and Localize locations, even if both are available.

• Stop and Pass Markers entered in Fill mode now extend one voxel into 
segmentation result.
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• Labels embedded in saved image data now extend over several slices.

• Option to specify patient ID and series description when saving DICOM or Curry-
format image data.

• Improved DICOM study UID handling when saving image data. Study UID now 
linked to primary image dataset.

• DICOM Patient Sex attribute is now left empty if sex is unknown.

• Improved DICOM compatibility for saved fMRI and SAM images.

• Improved DICOM compatibility for saved images without valid Patient ID.

• Improved cortex segmentation for datasets with enhanced blood vessels.

• Improved bias correction sub-sampling factors, which speeds up computation 
when in-slice and slice-thickness resolutions are substantially different. 

• Improved Create Brain Mask and Create Intracranial Electrodes Mesh for 
pediatric CT datasets.

• Improved notification text when activating Prepare Pial Surface checkbox in 
Create panel.

• Upper left corner of image data displays only shows time/frequency if related 
results are shown.

3.2.8  Source Analysis
• Magnetic dipole fits.

• Improved algorithm for Beamformer scans.

3.2.9  3D View
• During "Rotate (eternal)", progress bar does not show remaining time any more.

• Option to display Localize depth electrodes as trajectories using "Vector" symbol.

• Locations now have the additional shape “ellipsoids” (again).

3.2.10  Localize
• Project to Segmentation Result now calculates locations with sub-voxel accuracy.
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• Display selected Localize locations surrounded by highlight color, with original 
color still visible.

• Use larger symbols and thicker lines on high-dpi screens.

• In Grid Geometry, a warning is issued if a duplicate electrode label is used, and a 
new, unique label can be selected.

• In Grid Geometry, if the electrode label ends with a number, a delimiter is inserted
in order to separate label from appended contact number.

• In Grid Geometry, Update Labels now offers a smart choice for where to start re-
labeling, based on existing labels and current selection. 

• In Grid Geometry, "Spacing" is now checked per default.

• Option to load a Localize file via Localize menu.

• Allow creation of depth electrodes with just two contacts.

• Option to adapt any depth, strip, and grid electrodes in the Localize list. 

• Localize list columns for strength and normals are now right-aligned.

• Grid Geometry default mode changed from grid to depth electrode.

• Grid geometry labels can now be entered as plain text. In this case, numbering is 
automatic.

• Option to adapt depth electrodes (change spacing or number of contacts).

• x,y,z location resolution in Localize list increased to 2 decimal places (0.01 mm).

• When changing locations via the Change Locations panel and the 3D cursor is at 
one of the modified locations, 3D cursor (and any coupled oblique views) are now
modified as well.

3.2.11  Results
• Localize "Load all" option removed.

• Localize "Load" option now loads file without prompting for name.

• Pial surface and inflation settings are now considered when exporting surfaces or 
results to MATLAB.
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• Custom FEMs can now handle ten compartments.

• In result tree, collapsed sections now remain collapsed if tree contents change.

• Option to load FSL triangle mesh surfaces from .vtk files.

• In Statistics, the x Epochs checkbox is now also available for analyzing Currents.

3.2.12  Digitizer
• Updated ITK engine to version 5.0, used for point cloud matching.

3.2.13  Miscellaneous
• Option to reduce macro “Proceed” delay to 0, in which case no popup windows 

appear.

• Option to auto-parameterize data files opened via the macro "loop over files" 
functionality.

• Option to open read-only macros in an editor.

• When recording or replaying a macro, the currently used mouse pointer is now 
augmented with record/play/pause symbols that adhere to Curry’s UI style. 

• New Keyword *LC expands to the current value of the macro loop counter.

• Patch/Hotfix Installer: changed “click Next” string to “click Install”.

• Montage Editor: Fonts now consider Windows screen scaling. 

• Montage Editor: Removed multiple entries of the same electrode placement.

• Option to enable or disable beta-testing of new functionality in Launcher (a 
special dongle feature is also required). 

• Improved handling of file names vs file types for file names with extension when 
saving hardcopy files. 

• New keyword *CU expands to name of software (“CURRY 8”)

• Montage Editor: Added option to Unravel overlapping symbols in electrode 
placement. Auto-created electrode placements are automatically unraveled.

• Montage Editor: Added Sensor Placements for Quik-Cap Net 32, 64, 128 and 256
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• Montage Editor: On ‘Add All’, sEEG traces are now automatically sorted.

• Montage Editor: Added drag&drop multi-selection support.

• Montage Editor: It is now possible to specify the file path when saving a montage 
in mnt-Format.

• Password protection option: logon credentials can be verified against local Curry 
user database, local Windows users, or domain server.

• Optional features are only claimed if they can be used by the current product.

• CURRY uses an available version 9 license when no version 8 license is 
available.

3.3  Issues Addressed

3.3.1  User Interface
• Fixed a bug where the macro list icons were not displayed correctly if Windows 

screen scaling was larger than 200%.

• Fixed a bug that made popup toolbars sometimes trigger the wrong (i.e. first) 
image data server, not the current one.

• Fixed a crash when loading Curry with floating parameter panes.

3.3.2  Database
• Fixed a bug where deleting an entry via the context menu did not update affected 

open studies.

• Fixed a bug where deleting Curry parameter files via the context menu did not 
update affected open studies.

• Fixed a bug then prevented the “active wizard” file to be displayed in parent 
studies.

• Fixed a bug that deleted the file’s comment when using the import wizard.

• Fixed a bug that prevented updating database properties when clicking on a file 
item.
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3.3.3  Acquisition
• Fixed a display issue where Threshold lines were not displayed for other than the 

first artifact sequence.

3.3.4  EEG and MEG Data Import
• Fixed a bug that caused a shift in the event times when reading unsegmented 

XLTek data.

• Fixed a crash when scanning “digital trigger” channel, yielding more than 20,000 
events.

• Fixed auto-detecting functional data files that are parameterized but don’t have 
an extension (e.g. 4D Magnes format).

• Fixed inconsistency between Curry and ProFusion regarding “start of recording”.

• Fixed inconsistency between Curry 64-bit and ProFusion regarding event start 
times.

• Fixed a bug that prevented auto-detection of ProFusion format while data is 
cached.

3.3.5  Signal Processing
• Fixed a bug where, if working in the frequency domain, wrong values were output 

to the top right of the deviation/p-value timecourse plot.

• Fixed a bug where wrong statistics maps were displayed if the number of 
channels was changed after calculating statistics.

• Fixed a bug where zoom out sometimes was unavailable after zooming in in 
spectral display.

• Fixed a bug when the MGFP was computed for multiple groups.

• Saving a data range that spans over multiple pages now results in the correct 
number of samples.

• Ensure time cursor is centered correctly on the display page.

• Fixed potential crash when increasing EEG group count in an active study.
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3.3.6  Image Data Import
• None

3.3.7  Image Data
• Fixed a bug where in some cases, output of detected file format can be garbled.

• Fixed a bug where in some cases, if original image data are tilted, saved image 
data axis orientations are not determined correctly.

• Fixed a bug where DTI FA orientation symbols were not displayed.

• Fixed a bug where drawing markers didn't work correctly while recording a macro.

• Fixed a bug which led to the computation of bias field reconstruction even when 
the apply-flag was disabled. 

• Fixed a bug where Localize items could be displayed in the wrong color.

• Fixed a bug where BEM/FEM Geometry setup failed, if Prepare Pial Surface 
checkbox in Create panel was set.

3.3.8  Source Analysis
• Fixed bug when using high-resolution FEMs (with more than 2 million nodes) 

which caused the software to crash.

3.3.9  3D View
• Fixed a bug where label display for locations displayed as sphere symbols cannot

be switched off.

• Fixed a bug where Localize items could be displayed in the wrong color.

3.3.10  Localize
• Fixed a bug where Fpz and Cz were included when creating 10-20 system 

electrode locations.

• Fixed a bug where Project to Segmentation Result and Get Normals from 
Segmentation Results are not registered for undo operations.

• Fixed a bug where Update labels may erroneously warn that there are less 
entries than labels.
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• Fixed a bug where dipole simulation fails if performed for a single time point.

• Fixed a bug where Update Labels may append locations when starting with 
selected location.

3.3.11  Results
• Fixed a bug when creating custom FEMs, where model definition would be 

incorrect when not all compartments showed containment. 

• Fixed a bug where lead fields had no description.

• Fixed a bug where Ctrl + Click selection in result tree could not be used to select 
entries.

3.3.12  Digitizer
• Fixed an issue when where probed hint positions appeared to be lost 

occasionally using the Krios

3.3.13  Miscellaneous
• Fixed a bug where “Enter filename, shortcuts will be expanded” appeared 

repeatedly in the Output window when replaying a macro with file dialogs.

• Fixed a bug where image data folders selected from “most recently used” (MRU) 
list are now correctly detected as “Image Data”

4  Changes in CURRY 8.0.4 from CURRY 8.0.3

4.1  Highlights
• Neuronic EEG file format support.

• ProFusion EEG/PSG file format support without the requirement to install 
ProFusion software. However, an additional component may need to be installed 
in order to correctly read events.  

• Option to specify a dedicated data display font.
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• Report now has a thumbnail mode (activated via toolbar button) where small 
images are pasted without line feeds. 

• Improved Create Brain Mask and Create Intracranial Electrode Mesh for CT 
datasets with intracranial electrodes close to image brick borders; isolated groups
of voxels in intracranial electrode meshes are now excluded.

• Auto Oblique View mode in Image Data sagittal/coronal/axial displays now 
supports Localize locations, if no electrodes are present.

• Option to save hypnogram events as continuous file.

• Option to fit a magnetic dipole.

• Localize location list now has a context menu with options to delete, label, color, 
group, project, or invert the selected items.

• ROSA .ros trajectory file format support in Localize.

• Improved extraction of Statistics condition/group and category labels.

• Option to select range from 300 to 3000 mV peak-to-peak for Grael V2 and Grael 
V2 EEG.

• Krios Digitizer: Faster and more robust labeling algorithm.

4.2  Enhancements

4.2.1  User Interface
• Options dialog now allows to reset fonts and offers to restart after font changes.

• User can now override the menu font, dialog font, and dedicated data display font
instead of a combined menu and data display font.

• After deleting a macro file, the next macro file in the list becomes selected.

• Changed order of macro toolbar buttons so that at least the wrench is accessible 
on 1024x768 screens, which can still be found in some projectors.

• Only warn once per session when changing scope while a study is open.
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4.2.2  Database
• Legacy mdb database archives can now be opened by double-clicking.

4.2.3  Acquisition
• Option to select range from 300 to 3000 mV peak-to-peak for Grael V2 and Grael 

V2 EEG.

• Automatically detect channels whose unit is not Volt (such as SpO2, pressure or 
pulse channels) and exclude them from post-processing such as filtering.

• Grael V2 devices now supports detection of overlapping triggers (requires V2 
trigger module with firmware B2).

• Added option to select which device group shall be displayed in Acquire position 
plot view.

• Added information during MultiGrael connect and synchronization.

• Amplifier configuration dialog: Settings for base name and number are reset after 
use to prevent accidental use on other channels.

• Improved performance of time-frequency plot.

• MATLAB NetStreaming demo UI is now resizable.

• In Trigger Settings dialog, renamed “Neuroscan Stim2” mode to “Other” and 
made “Cedrus StimTracker” mode the new default.

• Default trigger refractory period for NuAmps set to 15 ms.

• Modified dedicated StimTracker trigger mode for Grael devices to support new 
Stim2 revision.

• Removed character count from Comments dialog.

• Position plot positions are now automatically reset when performing multiple 
acquisitions using different amplifier configurations in the same study.

• When using “Send Page To Functional Data”, the processed Data is now sent 
when the Process Filter Set is selected.

• Added configuration Grael V2 - Default (3V Range).

• Added configuration Grael – Quik-Cap Net 32.
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• Added configuration NuAmps – Quik-Cap Net 36.

4.2.4  EEG and MEG Data Import
• Added support for Neuronic EEG format.

• Shifted label-matching locations on the z-line to x=0 (Cz, CPz, etc).

• Accelerometer channels ACC0, ACC1, ACC2 are now detected as "Other" 
channels.

• Digitized head-shape points are now written to the parameter file when exporting 
functional data.

• Improved robustness of compressed file reader to be able to read files with 
incorrect sample information in first data block.

• The BDF importer now accepts files that do not follow exactly the file format 
specification.

• BrainVision importer now reads files from 3rd party converters.

• Using ProFusion EEG / PSG studies now does not need existing ProFusion 
installation(s) any more. However, an additional component may need to be 
installed in order to correctly read events (see Known Issues below).

• The path for Stellate files may now contain Asian characters.

• Adjusted column widths in the import wizard for high screen DPI.

• Improved autodetection of reference sensors in the import wizard.

• Added option “dot / comma decimal separator” in raw digitizer import wizard.

4.2.5  Signal Processing
• Improved Time-Frequency Analysis UI when showing only one channel.

• Option in Event List to shift all or selected events by definable time.

• Option to save hypnogram events as continuous file.

• Added expandable sections to Threshold Criteria dialog.

• Improved number formatting for strength display in Maps.
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• Improved performance of time-frequency display.

• Added capability to adjust size of time-frequency plot.

• Increased maximum supported study length.

• “Show Montage Across Groups” option now also works across device types.

• Modified time / frequency cursor values in Maps display to be more consistent to 
3D View and Image Data.

• "Add Noise” user interface is now hidden for deselected device groups.

• CSV export of spectra now contains 5 digits in Freq. Column.

• Waveboard: Better visible default colors, and epoch information added to channel
label.

• Added possibility to send range of channels to Waveboard.

• Event pre- and post-latencies are set from epoched data automatically.

• Shift and left-click can be used to modify left and right cursor-lines marking a 
time-range.

• Color of deselected channels in frequency domain now same as in time domain.

• Sending channel data to waveboard includes channel index / label when called 
from a macro.

• Improved display of all epochs without rereferencing.

• Improved order of rejection criteria to exclude epochs.

• Improved processing flags when modifying actual timepoint from options panel.

• Improved precision of latencies in functional data options panel.

• Improved plotting performance of waveforms with a large number of samples.

• Improved display order of data with PCA-/ICA-filtered timeranges.

• Contour line scaling improved/made more flexible.

4.2.6  Image Data Import
• Support for data intent and data description.
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• Included NifTi in "Analyze/SPM" image data hint.

• Wildcards are now observed when looking for image data files in sub-folders.

• Improved handling of image data folders containing a mix of DICOM and non-
DICOM files.

4.2.7  Image Data
• Improved robustness of automatic cortex segmentation by ignoring the white 

matter threshold defined in Image Data Parameters.

• When creating an intracranial electrode mesh, isolated groups of voxels are now 
excluded.

• Menu icon for Create Intracranial Electrode Mesh.

• Changed default symbol size when saving image data from 2 to 6 voxels.

• Improved Goto Nearby Maximum algorithm.

• Adjusted FEM mesh resolution defaults so that each step up yields an increase in
mesh elements of roughly factor two.

• When creating Points, there is now an option to add Talairach labels.

• Location labels (including Localize labels and Talairach location labels) are now 
included in MATLAB .mat files.

• Improved Create Brain Mask and Create Intracranial Electrode Mesh for CT 
datasets with intracranial electrodes close to image brick borders

• Auto Oblique View mode in ortho windows now supports Localize locations, if no 
electrodes are present.

• After loading an lh/rh freesurfer triangle mesh without color information, the other 
hemisphere can now automatically be added.

• Brainsuite dfs triangle mesh file format support.

• When loading a surface (triangle) mesh from a third-party file format, file name is 
used as surface name.

• Image Data (R,A,S) coordinate systems with origin in lower left inferior corner of 
image data brick.
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• Data intent and data description are displayed in the intensity scale.

• Switching to red/green mode for threshold display now only affects the local 
image dataset; it does not work across datasets any more.

• When zooming into and out of image data, the “All” mode does not extend to Grid
View any more, so that Grid View can always be zoomed independently.

• Segmentation results and markers are now preserved when creating an 
intracranial electrode mesh.

• A popup notification is created after a surface, points, voxel mesh, or mesh have 
been created.

• Talairach label display is now automatically activated after loading image data, if 
Talairach parameters have been defined.

• Undo now also works for Morphology operations.

• When saving RGB image data with currents or scan source results, low-intensity 
symbols don’t obstruct high-intensity symbols.

4.2.8  Source Analysis
• Improved performance of extended source calculations.

• Added magnetic dipole type to dipole fit.

• Improved plotting performance for multi-sample current density results in "time 
range summary" (maximum) mode.

• Improved performance of dipole scans with activated CDR.

4.2.9  3D View
• Location shape option “Vector” that draws a line with the location as start point.

• Added HPI coils to headshape points (and draw them in different sizes).

• Improved synchronization of Laplacians between Maps and 3D View.

• Improved consistency of manual scaling (dipoles, CDR) between 3D View and 
Image Data.
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•  Added option to display 3D coordinate labels in either Cartesian (x, y, z) or 
Neurologic (Right, Anterior, Up) mode. 

4.2.10  Localize
• ROSA .ros trajectory file format support.

• Location list now has a context menu with options to delete, label, color, group, 
project, invert order of, or invert the selected items.

• When creating a depth electrode and locations are selected, depth electrode 
contacts are inserted between the last selected location and its predecessor.

• When clicking outside of a location list entry, the selection is now reset and Edit 
mode switches to Append mode.

• Text of Grid Geometry’s "Update Grid" button changes to "Update Strip" or 
"Update Depth Electrode" depending on mode.

• Depth electrode spacing is now maintained independently from grid/strip spacing.

• Added a notification text explaining depth electrode update.

• Initialize macro loop counter with number of Localize locations when issuing the 
Localize.Action = GoToFirstLocation command. To use that value for the loop 
counter, the Mainframe.MacroLoopCounter must not be set when starting a loop 
with Study.Action = MacroStartLoop. 

• Added undo / redo support for Change Sensor Locations.

• Change Sensor Locations now also updates functional landmarks.

• Change Sensor Locations now does not switch to 3D View’s “6 Views" any more 
if there's already a "suitable" 3D View visible.

• Individual location's color info is now written to file when saving Localize locations
or Points created from Localize. 

• When creating a grid, strip or depth electrode via Grid Geometry and a group has 
already been defined for either contact, it will be used for all contacts.
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4.2.11  Results
• Statistics category labels are now always extracted together with condition/group 

labels.

• After auto-filling statistics grid, label assignment is now offered if labels already 
exist.

• When extracting statistics grid labels, a common substring across all grid entries 
is now ignored.

• Import Points to Localize now also works for surfaces.

• Increased maximum number of columns (subjects * repetitions) in Statistics 
design grid to 64.

• When exporting source results to MATLAB, strength units are now saved to .mat 
file as “curryuni” string.

• When exporting source results to MATLAB, the .m file comment section now 
includes explanation of unit string and more detailed explanation of deviation 
matrix.

4.2.12  Digitizer
• All Quik-Cap Net configurations now contain an optimized channel order used 

during digitization.

• Krios: Faster and more robust labeling algorithm (new option: “Automatically find 
Additional Hints”).

• Krios: NDLink properties are set automatically which simplifies the initial setup.

• Krios: “Accept” button is now enabled when Krios is in “probe” mode.

• Current positions can now be saved at any time, without the requirement that they
need to have changed after the last time they were saved.

4.2.13  Miscellaneous
• Report now has a thumbnail mode (activated via toolbar button) where small 

images are pasted without line feeds. 

• Macros can now be deleted using the <Delete> key.
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• Troubleshooting in the Options dialog now allows to deactivate crash reporting or 
to choose a mode where no patient-identifying data is transmitted.

• Improved robustness of parameter file updates in monitored folders such as 
Dropbox.

• Macro now records scope changes.

• Macro commands that close (including asking for saving changes, if applicable) 
or exit (without asking) the current study or Curry: Study.Action = 
MacroCloseStudy / MacroExitStudy / MacroCloseApp / MacroExitApp.

• Warn user on startup if auxiliary math library is not installed correctly or the CPU 
is not supported.

• Adding a view tab during macro recording does now activate it when replaying 
the macro.

• User interactions with data are now logged using Windows Event Log.

4.3  Issues Addressed

4.3.1  User Interface
• Fixed a bug where macro list in detail mode could not be sorted correctly by date/

time.

• Fixed a bug where up/down arrows in number fields may fail to change value in 
studies with unusual sampling rate.

• Fixed a crash when trying to dock parameter panes together.

4.3.2  Database
• Fixed a bug that displayed read-only legacy mdb databases as “writable”.

• Fixed a bug what only inserted the first file into the database, when dropping 
multiple files from the file explorer.

4.3.3  Acquisition
• Fixed a bug where stimulus events aligned to StimTracker event were sometimes

not added to an online average.
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• Fixed a bug where epochs that occurred in post-time-ranges of Bad Blocks were 
not rejected when a StimTracker Align time-range was defined.

• Fixed a bug where the Save and Send options in the Average Configuration 
dialog were switched during init.

• Fixed a bug where continuous wavelets in time-frequency analysis displayed 
modulus instead of just real part. 

• Fixed a bug where the block index of a file in Compressed Raw Float format was 
written incorrectly (waveform data was unaffected by this issue).

• Fixed a bug that could lead to trigger events being shifted (constant shift) when a 
second recording was done in the same study after reconnecting the amplifier.

• Fixed a bug where, after manually deleting an average from the average table, 
one remaining average was not saved to a Study Parameters file.

4.3.4  EEG and MEG Data Import
• None.

4.3.5  Signal Processing
• Fixed a bug where montages did not display bipolar traces between channels 

within Others device group.

• Fixed a bug where continuous wavelets in time-frequency analysis displayed just 
real part instead of modulus. 

• Fixed a bug in channel plot polarity (plus is up).

• Fixed a bug in event list display when concatenating files.

• Fixed ta bug in the FastFourierTransform of averaged spectral data.

• Fixed a bug when averaging spectra of epoched data from macro.

• Fixed a bug where after displaying TANOVA or Maps SnPM results, source result 
deviation maps are always shown as channel symbols.

• Fixed start time display of exported blocks from ongoing data with wall-clock time.

• Fixed a buffer overflow during prefetching large functional data files.
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• Fixed the noise-estimation in the vicinity of bad blocks.

• Fixed a repaint problem when computing Laplacians for hardcopies.

• Fixed the offsets of unreferenced, epoched data when using all epochs.

4.3.6  Image Data Import
• Fixed a bug where the number of slices was reset to one when reviewing 

parameters for a DICOM series consisting of a single file with multiple slices.

• Fixed a crash if image data file name is 260 characters or longer.

• Fixed a bug where for RGB NifTi files parameter autodetection fails.

• File paths containing Asian characters are now displayed correctly in the import 
wizard.

4.3.7  Image Data
• Fixed a bug where Create panel dropdown was empty after creating intracranial 

electrode mesh.

• Fixed a crash when creating a triangle mesh with “Prepare Pial Surface” checked.

• Fixed a bug where image data scale is not shown if "Bits per Pixel" is 32 and 
"Ignore First" is 0.

• Fixed a bug where the “Start” button in MATLAB panel remained grayed out.

• Fixed a bug where, when saving image data, warnings relating to items that 
should not be saved appeared in the Output window.

• Fixed a bug where in orthogonal and MIP views, Localize locations and points 
containing strengths (j) are rendered in monochrome even when using a 
colorscale.

• Fixed a bug where CDR statistics are not displayed if "Show Symbols" is 
checked.

4.3.8  Source Analysis
• Fixed head model selection when choosing magnetic dipole, always automatically

setting Infinite Homogeneous. 

• Fixed a crash that occurred when displaying more than 5 fitted dipoles.

• Fixed a problem where CDR calculations using points as source locations 
produced an error message.

Doc 6509 Rev G Page 45 of 94



COMPUMEDICS USA, INC.
Title: CURRY 8.0.6 Release Notes
Document Number: 6509 Revision: G
Revised By: JK Rev Date: 11/16/20
Written By: MXW Original Release: 07/20/16
Procedure Format 3090 Rev F

4.3.9  3D View
• Fixed updating “fixed views” when "locked" oblique cut-plane is modified.

• Fixed a bug that made “localize points” disappear after shifting.

• Fixed a bug in CDR manual scaling (could not enter meaningful values).

• Fixed changing highlight color in “localize points”.

• Fixed displaying distance / Talairach grid labels for small zoom levels.

4.3.10  Localize
• Fixed a crash when adjusting sensors and headshape points without landmarks.

• Fixed a bug where adding Localize locations was not correctly recorded to macro.

• Fixed a bug where Project All to Nearby Maxima could be undone.

• Fixed a bug where the results of “Change Sensor Locations” are lost after 
deleting all Localize entries.

• Fixed a bug that prevented saving “Changed Sensor Locations” when there was 
no Curry parameter file.

4.3.11  Results
• Fixed a bug where ROSA coordinate axis orientations were R,A,S instead of 

L,P,S.

• Fixed a bug where CDR statistics cannot be saved as csv (Excel) file.

• Fixed a bug where calculating CDR statistics on source results where some 
source locations were clipped by the head model could lead to a crash.

• Fixed a bug where concatenating source results failed if concatenating MEG 
results with EEG results.

4.3.12  Digitizer
• Fixed a bug where button states of a Krios were not correctly detected.
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4.3.13  Miscellaneous
• Fixed a bug where adding or deleting a macro left macro list in an unsorted state.

• Fixed a bug where "Unknown Choice" was logged to the Output window after the 
“Pause”-button was pressed in a Pause/Continue popup question.

• Fixed a bug that prevented the "Source Reconstruction" workflow item to be 
displayed when loading files without the database.

5  Changes in CURRY 8.0.3 from CURRY 8.0.2

5.1  Highlights
• New "FD, All" data display option that shows Functional Data, 3D View, Maps, 

Image Data in a layout that leaves most space for the Functional data display.

• Improved display of maps from unreferenced data.

• Option to display rate (BPM) in the Event List.

• Option to “Save Mean” and “Save Sum” when exporting Average files.

• Option to apply 50 and 60 Hz notch filters and harmonics at the same time.

• “Moving Window Average” with adjustable width to Filter options.

• Common map- / contour line- scale checkbox for multiple EEG or MEG devices.

• Different projections for colored electrodes in 2D maps display.

• Detection of sEEG, grid, and strip electrodes for FEM head modeling and oblique 
cutplane definition.

• Improved robustness of cortex segmentation and brain mask against mis-
estimated white matter threshold or segmentation seed slice.

• Option to save surfaces in Freesurfer format via Results "Save as STL/Mesh" 
right-click option.

• When saving image data in RGB DICOM format, the “Slices” color scale from the 
Colors panel is used, and histogram adjustments are observed.
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• When synchronizing studies and both studies use Talairach coordinates, use 
Talairach coordinates to synchronize cursor location.

• Improved default settings for Epilepsy scope: Image Data radiological orientation, 
Rereferencing, Baseline Correction, and Filtering panels initially visible, 
“Precomputed BEM” head model.

• Option to calculate statistics for epoched files from multiple subjects.

• TIFF hardcopy support.

• Improved flexibility of FEM when dealing with intracranial sensors, being able to 
handle grids/strips, needle and scalp sensors simultaneously.

• Added support for MultiGrael and MultiGraelEEG devices.

• Added option to record processed data in addition to raw data.

5.2  Enhancements

5.2.1  User Interface
• Option to cancel popup questions that have a "Cancel" button by pressing <Esc>.

• When saving a study via the File menu, an info text is now displayed informing 
the user that usually, saving studies is not necessary.

• Keyboard shortcuts (<Shift>+)<Ctrl>+Z for Undo/(Redo).

• New "FD, All" data display option that shows Functional Data, 3D View, Maps, 
Image Data in a layout that leaves most space for the Functional data display.

• Option to press P and N keys in data display to move to previous/next sample.

• Support for <Alt>-Key button selection in popup questions.

• "Rename" command in context menus are now disabled for read-only items.

• Acquire’s views can now be enlarged using the macro recorder.

• Changed *DT\ to *DT in some default paths and filenames to make it clear that a 
trailing backslash is already part of the desktop folder path.
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• View tabs and parameter panes are now “synchronized" when adding files to the 
active study.

• Parameters of unused modules are now dynamically hidden (e.g. during 
acquisition)

5.2.2  Database
• 64-bit version does not need depend on Access database component any more. 

That component led to problems with older Office installations.

• Reordered “Add new Subject” and “Add new Study” in context menus to make it 
more consistent.

5.2.3  Acquisition
• Added support for MultiGrael and MultiGraelEEG devices.

• Added option to record processed data in addition to raw data.

• Added option to split a recording.

• Added Event Actions to split a recording and disconnect the amplifier.

• Added a hidden parameter to define a top-offset (margin) in pixels to Acquire 
views.

• Added additional hardware information to Synamps Amplifier Info dialog.

• Added “minimum frequency” display setting to time-frequency analysis.

• Added option to Edit > Options > Acquisition to show simplified Acquisition 
parameter pane.

• Added option “Set Filter Frequencies” to channel right-click (context) menu.

• Added option to use 50Hz and 60Hz notch filter simultaneously.

• Added option [Main Menu] > Acquire > Network Amplifier Tools for easy access of
amplifier specific configuration utilities.

• Sending pages of data to Functional Data now contain 3D positions for all device 
groups.

• Offer option to keep waiting when timeout is reached during amplifier connection.
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• Revoke option to re-sync amplifier during impedance check.

• Updated icons in Averages event table

• Improved split-view display.

• In Average views, the main average is now plotted on top of optional overlaid 
averages.

5.2.4  EEG and MEG Data Import

• For electrode label-matching, use leftmost longest match (was: overall longest).

• Updated locations for T1,T2 (now at FT9/10) and A1,A2,M1,M2 (now at 
TPP9/10), SP1,SP2 (now at T11h/12h)

• XLTEK: classify DC1..12 and bipolar channels as Others and X1..18 as EEG.

• Brainvision events reader now uses both “Descriptions” and “Types” column to 
differentiate between event types.

• Added support for reading Stellate Harmonie 7.0 files.

• Curry Compressed Data files that are missing header information can now be 
corrected when a matching Curry Parameter file is available.

• Wizard will auto-detect reference channel when loading digitizer files.

• Added support for writing ProFusion EEG 4 format.

• Removed trailing "quote" from XLTek events.

• Disabled checksum checking to improve auto-detection of 4D Magnes files.

5.2.5  Signal Processing
• Maps with waveforms now update when changing time-cursor in Functional Data

• Common map- / contour line- scale checkbox for multiple EEG or MEG devices.

• Added different projections for colored electrodes in 2D maps display.

• Improved disable / enable state of Scan Events button.

• Removed the Reject-checkbox from Threshold Criteria Apply-section.
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• Contour-line increment is always available via scrolling in Thumbnail maps. 

• Wave-file export can now also be done on data with reference set to <Off>.

• Show info box after merging event list with Stim2 behavioral data file.

• When changing montages, Max. Displ. Channels is changed to show all montage 
traces.

• Improved handling of bad blocks in reverting from back-2-back epochs.

• Improved display of unreferenced data in maps- / contour-lines window.

• Improved Functional Data Information messages.

• 10/20 interpolation allows less than original number of channels.

• Changed appearance of deselected epochs in scrollbar.

• Added “minimum frequency” display setting to time-frequency analysis.

• In Event Dialog, the Modify / Create Event options are now in an expandable 
section.

• Added option to use 50Hz and 60Hz notch filter simultaneously.

• Detection of sEEG, grid, and strip electrodes for FEM head modeling and oblique 
cutplane definition.

• Added an option in Events to constrain voltage criteria to a time window.

• Added an error message when computing dipole clusters without scanning the 
data before.

• Added “Moving Window Average” with adjustable width to Filter options.

• Channels from Others group are now displayed when a montage does not 
contain any.

• Improved manual color scaling for sEEG electrode symbols.

• Added an option to invert selected channels.

• Added option to display rate (BPM) in the Event List.

• Added option to “Save Mean” and “Save Sum” when exporting Average files.

• Added option to apply 50 and 60 Hz notch filters and harmonics at the same time.
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• Enabled 10/20 data interpolation even when others channels are present.

• Removed trailing separators in coherence output.

5.2.6  Image Data Import
• none.

5.2.7  Image Data

• Improved robustness of cortex segmentation and brain mask against mis-
estimated white matter threshold or segmentation seed slice.

• Improved search strategy for segmentation seedpoints.

• Option to save surfaces in Freesurfer format via Results "Save as STL/Mesh" 
right-click option.

• When saving image data in RGB DICOM format, the “Slices” color scale from the 
Colors panel is used, and histogram adjustments are observed.

• Support for code pages other than ISO_IR 100 when saving DICOM data.

• When saving DICOM data, patient name according to database subject is used, if
not specified via image dataset.

• When synchronizing studies and both studies use Talairach coordinates, use 
Talairach coordinates to synchronize cursor location.

• Cursor location is now saved to Study Parameters.

• Option to show difference images with full dynamic range.

• Modified red/green threshold preview for better high-intensity contrast.

• Modified threshold sliders in Segmentation Preview and Segmentation result so 
that the upper limit is now 256, not 255.

• Updated bias correction algorithm engine.

• Electrode display using a colorscale now supports rereferencing.

• Improved Talairach parameters for standard built-in image data (ICBM-152). To 
activate, delete ICBM-152.imd (right-click in Output panel, Open File Location, go 
one folder up). Reported atlas locations for some source results might change. 
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• BEM/FEM Geometry: improved cortex segmentation in cases where brain volume
was underestimated.

5.2.8  Source Analysis
• Changed CDR dipole clipping from deviation- to strength-based.

• Mixed FEM allows source analysis with only scalp EEG sensors.

• Improved FEM Venant dipole model performance.

• Grids/strips can be used in multi-compartment FEM Intracranial/Mixed. 

• FEM Intracranial and Inside Sphere allow grids/strips located inside head model 
to be left inside (e.g. interhemispheric cases).

5.2.9  3D View
• Added option to emulate "depth dependent" mouse cursor in stereoscopic 3D.

• Added manual scaling for colored electrodes

5.2.10  Localize
• When creating a grid, strip, or depth electrode via Grid Geometry and one of the 

seed locations has a color assigned, that color is now used for the complete grid, 
strip, or depth electrode.

• When creating a grid, strip, or depth electrode via Grid Geometry and some list 
entries are selected, the last selected entry now determines which locations to 
use.

• Menu and toolbar button for Redo (in addition to Undo).

• Option to project all to nearby maxima and to create 10-20 system from Localize 
menu and Localize's 3D View context menu with choice of image data.

• Option to invert order of locations.

• Support for Unix-style line endings when opening a text file.

• “Create 10-20 System” used for electrodes from current study now assigns the 
labels recognized in study.
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• "Create 10-20 System" now assigns locations to T1,T2 (FT9/10), 
A1,A2,M1,M2,ML,MR (TPP9/10), SP1,SP2 (T11h/12h) electrodes.

• Support for pasting data from Excel to Localize.

5.2.11  Results

• Increased the maximum number of statistics result consistency (average) maps to
32.

• Increased the maximum number of statistics result p-values to 64.

• Changed delimiters used in statistics result labels. Interaction is now expressed 
by the letter ‘x’ and other commas replaced by semicolons.

• Changed the file extension of statistics average data files from .dat to .cdt.

• When saving results and a spherical head model is used, don't add "vcd" to the 
list of results file extensions shown in database.

• When saving results, append "Results" to suggested filename and only include 
study name if it is different from data file name.

• ROSA coordinate system support.

• Option to export CDR statistics to Excel.

• Option to append statistics descriptions to Report.

• Option to specify a custom mesh resolution when creating a FEM.

• Simplified user-interface for skull anisotropy in FEM.

• When saving average files from statistics, filenames are now written to output log.

• Added the “Mixed” sensor type configuration for custom FEMs, which allows to 
handle models with scalp and intracranial electrodes.

5.2.12  Digitizer

• Added option to save positions in CSV format.

• Added option to disable beep sound for “missing tool” when using Polaris 
devices.
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• Digitizer channel order from Amplifier Configuration can now also be used when 
Interpolation is not enabled.

• Small UI changes to improve separation between dialog sections.

• Updated iterative closest point algorithm engine.

5.2.13  Miscellaneous
• Updated Manuals.

• Applied “Spectre Mitgation” i.e. reduced vulnerability to “Spectre” exploit.

• LoadCurryDataFile.m now also reads epoch-labels and -information.

• Option to use empty hardcopy file name templates, in which case the last used 
folder will be suggested.

• When saving hardcopies, file format selection is now remembered.

• When using Curry I, <F>-Key defaults do not contain montage operations.

• In Epilepsy scope, image data display now uses radiological orientation.

• In Epilepsy scope, Rereferencing, Baseline Correction, and Filtering panels are 
now initially visible.

• Macro and parameter file support for cutplane properties.

• 3D cutplane offset is now saved to surface and other result files.

• In Epilepsy scope, “Precomputed BEM” is now the default head model.

• LoadCurryDataFile.m (which reads Curry data files in MATLAB) now supports 
cases where number of samples is -1.

• TIFF hardcopy support.

• The (initial) state of a newly added sequence dialog is now recorded correctly.

• Unused sequence dialogs are not recorded in the macro any more.

• Application now tries more often to reclaim its network license. It should be less 
often necessary to search for a new license if the network traffic is high.
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5.3  Issues Addressed

5.3.1  User Interface

• In data displays showing multiple Image Data sets (ID 1,2 etc.), the option to 
display 3D View has been removed from all but second-to-last row.

• Fixed a crash that occurred when loading certain “view tab” configurations.

• Fixed a bug that showed “Maps” instead of “Functional Data” controls when 
enabling optional view tabs.

5.3.2  Database
• Fixed a bug that displayed "Derived" as "Normal" studies when loading CDB 

databases.

• Fixed a bug that prevented reading MDA files containing multi-line comments.

• Fixed a bug that prevented the inserting of subjects into legacy MDB databases.

• Files are now correctly auto-detected when dragged and dropped from the 
desktop.

• Fixed moving files from “filed” to "unfiled" studies.

• Subject's address is now correctly exported to MDA files.

5.3.3  Acquisition
• Fixed an issue in the Trigger Settings dialog where the values of the first stimulus 

and response bit were not visible when the screen scaling was higher than 125%.

• Fixed an issue on Grael V2 amplifiers where impedance values appeared too 
high when using a sampling rate of 4096 Hz.

• Fixed an issue where spectral data may not have been colored in the specified 
range color.

• Fixed an issue where individual channel filters were not applied when loaded 
from a parameter file (.cfg) at study creation time.
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• Fixed a possible crash when handling certain mouse events in the montage 
editor.

• Fixed a possible problem when closing CURRY.

• Fixed a problem when drawing events to an empty screen.

5.3.4  EEG and MEG Data Import
• Fixed a bug that prevented auto-detection of BrainVision files containing UTF-8 

encoded characters.

• Fixed a bug that prevented reading European Data Format files larger than 2 GBs
correctly.

5.3.5  Signal Processing
• Fixed an issue where aligning stimulus events to StimTracker events was not 

considered in in-place averages and exported epochs.

• Fixed an issue in the sensor coherence csv export.

• Fixed crash when changing the number of displayed channels in time-frequency 
plot when autoscale is off.

• Fixed a possible crash when displaying PCA filtered data in studies with 
concatenated epochs.

• Fixed a problem where the text in the File Information dialog was clipped.

• Fixed merging of MEG and EEG from two separate files in a study. 

• Fixed a problem with the event list when adding files to an open study. 

• Fixed threshold event counter for concatenated files.

• Fixed in-place averaging without data pre-fetch buffer.

• Fixed a problem with the last sample in Bad Block Removal.

• Fixed a memory leak when reading noise statistics from file.

• Fixed a problem where “Show This Channel Only” could show the wrong channel.

• Fixed a problem caused by string overflow from data outliers.
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• Fixed a problem when writing Bad Blocks for concatenated files.

• Fixed a problem when exporting epochs from concatenated files via event list and
display of valid epochs.

• Fixed a problem with the vertical offset of butterfly plots including other channels.

• Fixed a problem where the Functional Data Import dialog appeared twice when 
inserting multiple files into an unfiled study.

• Fixed a problem when concatenating dipole results.

• Fixed a problem in the Butterfly plot where channels from the Others group were 
not plotted in their designated area.

• Fixed a problem in the STFFT display.

• Fixed a problem when saving while saving study parameters.

• Fixed a bug that detected an unparameterized image data directory as functional 
data.

• Fixed a bug when reading EDF files larger than 2 GB.

• Fixed a bug that prevented setting the checkbox state of the functional data 
pipeline when replaying a macro.

5.3.6  Image Data Import
• Fixed a bug that, when using radiological orientation, Talairach bounding box left 

and right dimensions could not be changed in axial and coronal views.

• Fixed a bug that led to resizing problems when specifying image data thresholds.

5.3.7  Image Data
• Fixed a bug where CDR was displayed as a grid, if symbol mode and spheres 

were selected.

• Fixed a bug where frequency domain CDR display was wrong.

• Fixed a bug where dipole display scaling in single time point display mode (movie
mode) doesn’t work when using clipping.

• Fixed a bug where menus for grid view orientation and oblique view didn't work.
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• Image intensity values as displayed in the user interface may in some cases be 
limited to half the actual range.

5.3.8  Source Analysis
• Fixed a bug where largest regional/fixed CDR dipole location is not computed 

correctly for a time range.

• Fixed a bug where largest two/largest per hemisphere regional/fixed CDR dipole 
locations are not computed correctly for a time range.

• Fixed issue with “Project interior grids/strips outwards” setting in FEM intracranial,
where all grids/strips are inside source compartment.

• Fixed issue in preprocessing of intracranial models which could lead to incorrect 
sensor deselection.

5.3.9  3D View
• Regional dipoles are now displayed correctly in 3DView (regarding scale and 

color).

• Fixed size of 3D dipole symbols in movie mode (were always "uni").

5.3.10  Localize
• Fixed a bug where Import Coils assigned wrong labels and normals for MEG 

gradiometers.

5.3.11  Results
• Fixed a bug where column headers in Statistics csv export may be split across 

several spreadsheet columns if they contain a comma.

• Fixed a bug where exporting results to Excel (csv) files created empty files.

5.3.12  Digitizer
• none.

5.3.13  Miscellaneous
• Fixed a bug where Talairach coordinates could not be selected as the coordinate 

system
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• Fixed a bug where interactions leading to the appearance of a file dialog 
sometimes appeared twice in recorded macro.

• Fixed a bug where deleting a macro folder resulted in an error message.

• Fixed a bug where, when recording a macro and a popup question appears, 
intermediately modified parameters are not recorded.

• On Windows 10 1703 (Creators Update), after pasting images into Report it is 
impossible to save Report or to Open in Editor.

• Scanning configuration files with large number of channels (>700) now works 
correctly at all times.

6  Changes in CURRY 8.0.2 from CURRY 8.0.1

6.1  Highlights
• Added support for Grael V2 PSG, Grael V2 EEG and Grael LT.

• Improved NDI Krios performance and workflow.

• Improved File History for Acquisition and Functional Data files.

• Added “Morse Wavelet” to time-frequency analysis.

• Option to choose slice orientation when saving DICOM images.

• Option to display two simultaneous Grid Views and to change Grid View 
orientation.

• Oblique view mode for Image Data Orthogonal and Grid Views.

• In 3D View, sagittal, coronal, and axial cutplanes are now angulated like their 
corresponding image data cross-sections, including support for oblique 
orientations.
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6.2  Enhancements

6.2.1  User Interface
• Curry version and modules in use are now displayed in the lower right part of the 

status bar. All version-related dialogs now show the current hotfix number.

• Removed potential mouse cursor flickering while PCA / ICA is active.

• Double-clicking warning icon on status bar now opens associated workflow group.

6.2.2  Database
• Deleting and moving files from and to “recording” study is now blocked to ensure 

acquisition stays visible at all times.

• Adjusted context menu items for removing files to show the correct context 
(...from Study, ...from Subject, ...from Group)

6.2.3  Acquisition
• Added support for Grael V2 PSG, EEG and LT.

• Added support for Siesta Amplifier to Curry Express version.

• Added “Morse Wavelet” to time-frequency analysis.

• Added Teager-Kaiser energy operator to time-frequency analysis.

• Added option to automatically put online average files into individual sub-studies 
in the database.

• Added option to hide and/or not record auto-created events.

• Template events below set thresholds are no longer passed to MATLAB or via 
TCP/IP streaming.

• Online Average files now contain settings of Process filter set in File History.

• Channels from Other group are put into EEG group when otherwise recording 
would only contain an Other group.

• “Max. Displ. Channels” option is now stored in parameter files (cfg).

• Changed [sec / mm]-option to [mm / sec].
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• Individual channel scaling is now defined in μV / mm.

6.2.4  EEG and MEG Data Import
• Added support for reading “other” channels from EGI-MFF file format.

• Added support for Nihon Kohden 1200 file format.

• Added support for XLTEK “version 7” segmented files.

• XLTek reader uses creation date of first ERD file if date provided by SNC file is 
invalid.

• Trigger offset is now preserved for files that contain a “start of recording” date.

• Landmarks are now extracted from EGI MFF coordinate.xml files.

• A warning is presented when landmarks are missing and "sphere center 
subtracted" is applied to the sensor locations of a device group.

• Added support for reading Micromed files containing “unused” channels.

6.2.5  Signal Processing
• Small UI improvement for Energy Operators in Frequency Domain dialog.

• Added option to insert event types at regular intervals.

• In Maps, switch result type only if selected result type is unavailable.

• File history contains information on baseline correction.

• File history of In-Place Averages now contains processing history of source data 
file.

• Added file history to Epoched files.

• Added option to filter events by annotation text to event conditions dialog.

• Added amplitude scale to the Maps display.

• Added Teager-Kaiser energy operator to time-frequency analysis.

• Added “Morse Wavelet” to time-frequency analysis.

• Improved montage handling for multiple groups.

• Scrollbar displays only valid template events.

Doc 6509 Rev G Page 62 of 94



COMPUMEDICS USA, INC.
Title: CURRY 8.0.6 Release Notes
Document Number: 6509 Revision: G
Revised By: JK Rev Date: 11/16/20
Written By: MXW Original Release: 07/20/16
Procedure Format 3090 Rev F

• Navigating events using scrollbar now sets time cursor.

• Options in Color dialog re-arranged for better visibility.

• Upper filter frequencies constrained to be lower than Nyquist frequency to avoid 
numerical problems with higher order IIR-filters.

• Improved artifact and template scan logic.

• Improved x-scale offset for waveboard.

• Display recording start date and time.

• Maps now scale to maximum timerange value.

6.2.6  Image Data Import
• Preserve DICOM caret delimiters in patient name.

• Support for DICOM Patient ID tag.

• Support for Elekta fif image data files, including fiducials.

• Option to add curvature, area, or thickness information after loading a Freesurfer 
surface file.

• Improved logic for determining axis lengths from Quaternions in NifTi files.

• Improved auto-detection of EDF files.

6.2.7  Image Data
• In BEM/FEM Geometry, electrode-related UI elements are now disabled if study 

doesn't contain EEG data.

• After voxel mesh creation, output number of triangles created and only mention 
"avg." side length if voxels are not cubic.

• Option to imprint electrode and Localize labels in saved image data.

• Skin thresholds that are too low are now avoided.

• In Segmentation Result and Segmention Preview, upper segmentation threshold 
is modified if <Alt> key is pressed while using the mouse wheel.

• Option to change orientation for grid views.
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• Support for multiple grid views.

• Option to activate Oblique View mode for grid views via Image Data menu or grid 
view context menu. If enabled, grid view will switch to Oblique View mode if the 
corresponding (typically, the sagittal) ortho view is in Oblique View mode.

• In Options panel, changed "Transparency Atlas" to "Transparency Overlays" as it 
also applies to overlaid thresholded image data.

• Skin color is now only assigned to surfaces whose volume is larger than 2700ml 
(was: 2000ml).

• Cortical thickness is now calculated during pial surface creation.

• Option to choose slice orientation when saving DICOM images.

• Option to save DICOM images in Talairach space.

• Option to view and update segmentation thresholds based on image intensities.

• Support for radiological orientation in image data parameter windows.

• Oblique View option via orthogonal slice context menu. In all modes, adjustable 
via <Ctrl>+Cursor Keys. In Auto, In-Plane, and Orthogonal modes, Oblique view 
can be set by clicking an sEEG (needle) or a grid electrode. 

• Option to extend skin compartment for BEM and FEM meshes in Advanced 
section of BEM/FEM Geometry panel. If activated, skin compartment is 4cm 
larger in order to accommodate subtemporal and cheek electrodes.

• In Create panel, changed "Wider" to "Mesh Refinement".

• Option to use global zoom factor (+/- keys affect all orthogonal views).

• Definition of transformation quaternions (qform_code=1) when saving NifTi files.

• Offer to include Localize in saved Image Data even if not shown in 3D View.

• Offer to remember the answer to popup info when autodetecting landmarks.

• Correct for unrealistically high magnetic field strengths in DICOM header.

• Voxel meshes can now be inflated in 3D View.

• Mouse position and segmentation threshold slider now match when histogram 
adjustment has been changed.
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• CDRs and Scans displayed as symbols are now always shown solid, if 2D 
Distance is enabled.

• Improved rendering of angular displacement in Segmentation Preview, 
Segmentation Results, MIP, Oblique Views.

6.2.8  Source Analysis
• Dipole clustering improved to support large source location/epoch/sample counts.

• Dipole clustering out-of-memory treatment improved.

• Inclusion of the next inner compartment to the source space is now supported for 
FEMs when created manually via Results>FEM Model.

• Inside Sphere and FEM Intracranial head models can now handle electrocortical 
grids as well as combination of grid and depth electrodes.

• Improved electrode position estimation in Scalp-EEG FEMs, now using projection
to the outer surface and subsequent interpolation for potentials calculation.

6.2.9  3D View
• Shifted standard cortex one mm to the right in order to better match built-in MRI.

• Sagittal, coronal, and axial cutplanes are now angulated like their corresponding 
image data cross-sections, including support for oblique orientations.

• Option to display BEM and FEM head models that have not been loaded yet.

• Added warning if DirectX 11 is not available on target computer.

• Objects panel stays open when opening Change Locations panel.

• Option to activate depth-dependent transparency for surfaces.

• Option to color-code surfaces.

• Improved scaling of electrode labels.

• Removed "arbitrary rotation" of electrode label text.

• Locations containing only positive values are now mapped to the full color range.

• Improved readability of 3D text on spheres (less spread).
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• Electrodes are now deselectable in view (Shift + Ctrl + Click).

6.2.10  Localize
• Strengths are preserved when creating Points and can be displayed by switching 

to colorscale.

• Change Locations now moves locations relative to rotated views such as 3D View
or MIP (if visible).

• Elekta bdip file format support.

• Output info about grid, strip, depth electrodes created in Localize.

• Retain selection when switching between Edit and Show mode.

• In Change Locations panel, Move Selected is now also supported in Show mode.

• When switching between Edit and Show mode, lower UI panels now stay open.

• When selecting Append mode from context menu, always switch to Append 
mode. 

6.2.11  Results
• Option to calculate statistics for epoched files from multiple subjects.

• Use complete filename for Statistics dropdown selectors, even if it contains dots.

• Added support for source reconstruction results export to GNU Octave.

• Tetrahedral mesh refinement option in FEM Models dialog, either in: a) manually 
defined regions by pass markers, b) automatically in the vicinity of stereo-EEG 
leads, or c) the combination of a) and b)

• The following popup window is now displayed when loading a Freesurfer surface 
from Results: “In order to correctly co-register Freesurfer triangle meshes, the 
T1.mgz MRI created by Freesurfer must be part of the study and it’s 
corresponding Freesurfer coordinate system must have been selected.”

• Coordinates menu now lists NifTi as an available coordinate system.

6.2.12  Digitizer
• NDI Krios: 
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◦ Option to interpolate missing electrode positions.

◦ Option to show distances between point cloud and template.

◦ Option to switch off 3DView following Krios movements.

◦ Improved workflow and performance.

6.2.13  Miscellaneous
• Macro delays (for popups, questions, and banners) can now be longer than 10 

minutes.

• Macro recording optimized to avoid executing the same action twice.

• Montage editor now scales electrode symbols to mitigate situations where they 
overlap.

• Shortcuts such as *SU (subject name) etc. can now be escaped by using a 
backslash, which can be prevented by a double backslash. Examples: *SU is 
expanded to subject_name, \*SU is expanded to *SU, and \\*SU is expanded to \
subject_name.

• Added dedicated dongle features for BTI and CTF MEG readers.

• Added command line option to query all optional dongle features. Example: 
“/PTCurrySBA+”.

• Launcher will be started to issue a warning if dongle service is not running.

• Double-clicking on warning icon in status bar will now open the associated 
workflow group.

6.3  Issues Addressed

6.3.1  User Interface
• Fixed issue where menu to add step to Functional Data processing chain did not 

appear.

• Most recently used (MRU) files are now stored with absolute paths, so that they 
are always found, even when the database changes.
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6.3.2  Database
• Fixed a bug that made a file appear twice in the database when dragged from 

explorer

6.3.3  Acquisition
• Fixed a crash when receiving trigger events from Neuvo amplifiers in

CURRY 64-bit.

• Fixed a bug where Average View parameters were not retained after 
(re-)connecting amplifier.

• Fixed a bug when closing Curry while NuAmps is in impedance mode.

• Fixed a bug where Average waveforms were not displayed.

• Fixed a bug where individual channel filters were not applied when parameter file 
(cfg) was loaded before a connection to an amplifier was established.

• Fixed a bug where online averages were not saved to disk.

6.3.4  EEG and MEG Data Import
• Fixed a crash in Functional Data Wizard when gradiometers are available and all 

electrode sensors are set to “Off”.

• Fixed a bug that may lead to rejecting ProFusion PSG 3 studies containing EMG 
channels.

• Fixed a bug when writing parameter files for data that contains multiple groups 
and reference channels.

• Fixed a bug that prevented caching of Nicolet and Stellate files in 64-bit mode.

6.3.5  Signal Processing
• Fixed a crash when ICA is triggered by study parameters and Maps UI is not 

initialized yet.

• Fixed a crash when saving down-sampled data where no appropriate aliasing 
filter has been applied yet.
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• Fixed a bug in the Save Options dialog where a Matlab selector could not be 
changed.

• Fixed a bug in the Save Options dialog where “Show Area” checkbox was not 
visible when saving intervals.

• Fixed a bug where the selected reference channel was not appearing in the File 
History of exported files when multiple reference channels were used.

• Fixed a bug where the Align[ms] option was not directly applied when changed.

• Fixed a bug where montages could be wrongly displayed as "invalid" for a group

• Fixed a bug where F-key could apply wrong montages across groups 

• Fixed a bug that may lead to clipping artifacts when exporting unreferenced data.

• Fixed a bug that may lead to incorrect values when exporting peak signals of 
unreferenced data.

• Fixed a bug that may lead to montage settings in study parameters not being 
applied.

• Fixed a bug when using all epochs with constant baseline correction.

• Fixed update of filter slope in auto-mode.

• Fixed warning during data import when appropriate license is missing.

• Fixed / ignore Average Data setting from study parameters for continuous data.

• Fixed display of unreferenced electric data (appeared with CAR) when changing 
noise estimation.

6.3.6  Image Data Import
• none

6.3.7  Image Data
• Fixed a bug where FEM creation would abort in the absence of electrodes when 

having mesh refinement “Near Electrodes” active.

• Fixed a bug where dotted Talairach grid lines are rendered incorrectly if Talairach 
grid labels are switched off.
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• Fixed a possible crash after canceling out of Image Data parameters.

• Fixed a bug where Stop/Pass marker locations in saved image data are wrong, if 
image data have non-cubic voxels and “Axes, Slices” used for saving are “Raw”.

• Fixed a bug where voxel mesh (raw) was sometimes incorrectly rendered.

6.3.8  Source Analysis
• Fixed a crash when performing source analysis with inflated Standard Cortex as 

source surface.

• Fixed a crash when having a FEM active in source reconstruction and enabling 
MEG data.

• Fixed a bug that prevented display of MATLAB CDR Dipoles.

• Fixed a crash when using a newly created stereo-EEG FEM with the subtraction 
dipole model.

6.3.9  3D View
• Fixed a crash that occurred when plotting a surface/BEM/FEM model that exists 

on disk but has previously been deleted via the Result tree.

• Fixed cut-plane “interior” for FEM head models.

• Fixed line width for wireframe surfaces with enabled cut-plane.

• Cut-planes for electrodes and coils now work correctly.

• Labels of transparent electrodes are now clipped correctly behind opaque 
surfaces.

• Fixed a bug that made electrodes disappear when using “2D Visibility”.

• Cut-plane's image data is now preserved when working with multiple studies.

• Fixed crash when displaying waveforms for dipoles.

• Fixed a bug that lead to perspective problems when importing legacy Curry 7 
parameter files.

• Troubleshooting page now shows correct mode if DirectX 11 is not available.

• Removed duplicate entries from “scale” and “time-range” combo boxes.

• Fixed clipping inconsistency of CDR results in “symbol” mode.
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• Fixed a crash when displaying CDRs and the current sample is out of range.

• Fixed a bug when displaying transparent RGB and LUT image data cutplanes.

• Oblique cutplane's offset modified by Ctrl + wheel is now memorized correctly.

• Fixed a bug that prevented displaying symbols on very coarse CDR grids.

• Removed negative range from color scale in frequency mode.

• Force symbols to be non-transparent to prevent display problems when plotting a 
large number of symbols.

6.3.10  Localize
• none

6.3.11  Results
• Fixed a bug that lead to a crash if an out-of-memory condition occurs in Statistics.

• Fixed a bug in BEM Model dialog, where after creating a BEM via Image 
Data>BEM/FEM Geometry, the “Setup New Model” button was disabled.

• Fixed a crash if “drag and drop” would occur in the compartment definition tables 
of the BEM/FEM Model dialogs.

• Fixed a bug where, after stopping BEM/FEM creation, subsequent overlay import 
does nothing.

6.3.12  Digitizer
• Fixed a bug where the speech recognition for NDI Polaris devices was not 

working.

6.3.13  Miscellaneous
• Fixed a bug where sometimes, after installing a hotfix, a request for sending an 

install notification would be made.

• Fixed a bug that prevented saving Curry Study Files (cst).

• Double-clicking Curry Parameter Files (dpa) now opens the associated functional 
data file / directory (if extension is registered).
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7  Changes in CURRY 8.0.1 from CURRY 8.0

7.1  Highlights
• NifTi-2 file format support

• Option to save image data in NifTi file format

• Option to create 32, 64, 128, 256 channel cap and 5%, 10-5, 10-10, 10-20 
system layouts

• Support for 3D stereoscopy in 3D View

• Option to define oblique cut-planes in 3D View

• Option to apply a montage on live data sent to MATLAB or via NetStreaming

• Support for NDI Krios device (through NDI Development Utility, NDLink)

7.2  Enhancements

7.2.1  User Interface
• Option to create hard-copies with enlarged fonts

• Improved appearance of several UI elements on HighDPI screens

• Color chooser's pop-up grid now highlights currently selected color

• Context menu of Output window now also works in “enlarged mode”

• Enlarged report bar is now restored correctly below its toolbar

• Prevent Functional Data Wizard from claiming too much horizontal space on 
HighDPI screens

7.2.2  Acquisition
• Added amplifier configurations for new Quik-Cap Net (32, 64, 128 and 256 

channels) and MicroMagLink 68

• Grael and Grael EEG amplifiers support showing impedances on bipolar 
channels (+ and – channels)
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• Option to apply a montage on data sent to MATLAB or via NetStreaming

• Option (in Edit > Options > Acquisition) to set the online data framerate to handle 
performance issues on slow computers

• Improved performance of sending TCP/IP packets in BCI mode to minimize delay

• Reordered Filter Type selector to show most frequently used types at the top

• “Start Amplifier” button changes to “Stop Amplifier” after successful connect

• Displayed impedance values are no longer clipped to the maximum scale value

• Draw spectral lines in colors assigned to frequency bands

• MATLAB Netstreamingdemo.m now works without manually setting the path

• Show colored bars for StimTracker events (when they are used for an average)

• Hide Time-Frequency display area after a reconnect, when Time-Frequency 
analysis is turned off

• Option to reset Trigger Settings options back to defaults

• Prevent “Server Busy” message while setting up Acquire video camera

• Acquisition > Amplifier Control > Trigger Settings button becomes bold to notify 
that settings have been changed

7.2.3  EEG and MEG Data Import
• EDF importer now reads files containing individual sampling rates per channel

7.2.4  Signal Processing
• Automated CAR-rereferencing of EEG-data when no reference channel is given 

explicitly

• Export of frequency and coherence data now supports CSV format

• Save Data using MATLAB format now supports new cdt file format

• Improved performance when displaying spectra

• Reordered Filter Type selector to show most frequently used types at the top

• In Maps, single-latency statistics now have gray backdrop if insignificant
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• Frequency Data export in .txt-format now contains channel labels and frequency 
bin information

• Show colored bars for StimTracker events (when they are used for an average)

• Improved handling of epochs with events

• Improved placement of Functional Data cursor when pausing video replay

• Event Conditions dialog table and Maps View PCA / ICA check-boxes consider 
global Windows scaling

• "Advanced" section in Options is now initially collapsed and in-sync with button 
state

• Increased frequency resolution for continuous wavelets

• Improved scaling option in time-frequency's color-coded plot

• Video Replay dialog supports up to three simultaneous views

7.2.5  Image Data
• Create meaningful Talairach coordinates if MS landmark is lower than AC

• Option to Add Image Mask fills areas without image data with Stop Markers

• Create Brain Mask from CT data now works for scans where part of the brain is 
missing and thin skulls

• NifTi-2 file format support

• Support for units other than mm in Nifti files

• Image data scale labels now show modality or NifTi intent string

• Option to save image data in NifTi file format

• Consider Stop and Pass Markers when saving image data, even if saving in 
Original or Talairach space

• When saving image data in RGB DICOM format and working with RGB image 
data, save image data as RGB

• Option to prepare pial surface for cortical triangle meshes in Image Data Create

• CT brain mask uses bone tissue Hounsfield units (500 to 1500), if available
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• Views for adjusting segmentation thresholds now show image intensities in tool-
tip 

7.2.6  Source Analysis
• Option to extract “Largest per Hemisphere” CDR Dipoles retrieves two dipoles 

(one per hemisphere) if source space was a 3D grid

• Enable high-resolution 3D Grid source space (< 1 mm)

• Area of extended sources is now displayed in Source Locations panel

• Improved implementation of the Venant dipole model for FEM

• Performance improvement in FEM lead field computation through parallelization

• In the Head Models panel, "Constrain Source Space" text is changed to "Exclude 
Cerebellum" if BEM Precomputed is used as the head model

7.2.7  3D View
• Support for 3D stereoscopy (requires Windows 8 or higher and 3D capable 

monitor)

• Option to define oblique cut-planes

• Set allowed range for the width of waveform objects to [10, 1000] pixels

• Improved rendering of source coherence arcs

• Tooltips and click / double-click support for surfaces in wireframe mode

• Prevent color scale from being displayed when coherence arcs are drawn in 
monochrome color

• Time-dependent, saved results are not drawn outside their valid range any more

• Prevent color scale from switching back to "Maps" when both "Maps" and "CDR" 
are displayed

7.2.8  Localize
• Warning message if creating 10-20 system and landmarks are not initialized yet
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• When using “Adjust Sensor Locations” in the Change Locations panel, sensor 
types (EEG or MEG) that are completely disabled are not modified

• Option to create 32,64,128,256 channel cap and 5%,10-5, 10-10, 10-20 system 
layouts

7.2.9  Results
• Statistics: order output of significant segments by latency instead of duration

• Statistics: use absolute t-values for SnPM consistency tests

• Support for loading and saving Elekta triangle .mesh files 

• For single-sample or collapsed-samples statistics, don't test for length of 
contiguous significant segments

7.2.10  Automation
• When using shortcut expansions such as *DF, *IF, etc in macros for text in popup 

windows, banners, Report or Output text, the asterisk can now be escaped using 
a backslash in order to avoid expansion (\*DF, \*IF, etc)

7.2.11  Digitizer
• Support for NDI Krios device (through NDI Development Utility, NDLink)

• For NDI Polaris devices: Display warning texts when tools are not visible

• “Start Digitizer” button changes to “Stop Digitizer” after successful connect

7.2.12  Miscellaneous
• CURRY 8 Launcher tries to start License service (hasplms), if it is not running

• Updated documentation

• Vendor and CE information added to Help > About

• Allow ‘0-back’ in Event Conditions

• New MATLAB example script “ExamplePlotWithLabels”
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• Output log files now contain regular “space” characters instead of the slightly 
smaller variants used for separating values and units in the Output panel

7.3  Issues Addressed

7.3.1  User Interface
• Fixed a bug that displayed toolbar tooltips clipped

• Fixed a bug that prevented using Copy and Paste from and to edit controls

• Fixed a bug that lead to display problems in the Maps > Parameters dialog when 
using multiple device groups

7.3.2  Database
• Fixed a bug that showed the status of image data folders containing a dot as 

"missing"

• Fixed a bug that may lead to display problems after deleting a group item

• “Auto run Macro” property cannot be applied to read-only databases any more

7.3.3  Acquisition
• Grael or Grael EEG: Trigger channel was initially disabled when creating new 

amplifier configurations

• Fixed a problem where data from multiple Synamps2/RT headboxes were scaled 
by the scaling factor of the first headbox

• Fixed display of spectral data in a butterfly plot.

• Fixed a problem in Artifact Reduction, where the ‘All’-Average was not recreated 
after a manual reset

• Fixed a crash when closing an acquisition study while time-frequency-analysis 
was active

• Fixed a crash that could happen when real-time processing of live data was not 
achievable
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• Fixed a crash when connecting to a Synamps2/RT amplifier fails and a message 
box shows up

• Fixed a crash when receiving trigger events from a Grael amplifier in 64bit

• Fixed a possible crash in recordings with several thousand events

7.3.4  EEG and MEG Data Import
• Fixed a bug that prevented loading parameterized files that do not have an 

extension in their name (e.g. 4D Magnes format)

• Fixed a bug that affected resorting “other” channels when reading parameterized 
files

7.3.5  Signal Processing
• Fixed a bug where concatenation of short files did not work correctly

• Fixed a bug where display montages were not applied on EEG device groups 
when MEG device groups have been switched off

• Fixed a bug where montages would not display channels from Other device 
group

• Fixed a crash when loading files in compressed format where channels have 
been turned off in the Functional Data Import dialog

• Fixed a problem where the On-the-fly annotations dialog was too small to type 
text

• Fixed a bug in averaging and noise statistics of epoched data

• Fixed a crash when scanning events for frequency thresholds

• Fixed a bug when up- / downsampling using odd sampling rates

• Fixed bug in time-frequency analysis, where parameters “Resolution” and “Max. 
Freq.” always started with the minimum possible value and where not being read 
from saved parameters

• Fixed bug in time-frequency analysis, where the “Show Wavelet” button was not 
displaying the correct wavelet

Doc 6509 Rev G Page 78 of 94



COMPUMEDICS USA, INC.
Title: CURRY 8.0.6 Release Notes
Document Number: 6509 Revision: G
Revised By: JK Rev Date: 11/16/20
Written By: MXW Original Release: 07/20/16
Procedure Format 3090 Rev F

• Fixed a bug in time-frequency analysis, where continuous wavelets wouldn't be 
shown when switching from other time-frequency method

• Fixed a bug when saving non-CAR’ed data in EDF format that led to clipping of 
channel values

7.3.6  Image Data
• Fixed a bug where image intensity in segmentation threshold and histogram 

tooltips was wrong, if look-up-table had been changed

• Fixed a bug where image red-green segmentation threshold overlay in histogram 
window was wrong, if look-up-table had been changed

7.3.7  Source Analysis
• Fixed erroneous creation of custom FEM models where compartment definition 

was not from outside to inside

7.3.8  3D View
• Fixed a crash when starting a digitization when multiple documents are / were 

open

• Fixed a bug that prevented updating the state of the “Pial Surface” check-box in 
the Object’s Properties

• Fixed a drawing problem when displaying coherence arcs and confidence 
ellipsoids simultaneously

• Fixed the direction of coherence arcs arrows

• Fixed a bug that prevented labels of “selected” electrodes from being plotted in 
the wizard’s 3D preview

• Removed double entries from contour lines' "Display Mode" drop-list

• Fixed a bug that prevented a single wireframe object from being displayed

• Dipole symbols can now be displayed transparently

• 3D View's cursor can now be displayed in line widths larger than 1

• Fixed a bug that prevented cut-planes from being applied to electrode and coils
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• Removed unsupported “Parallel Projection” from Options user interface

• Removed unsupported “Double” and “Triple” cut-planes from electrodes and coils 
property user interface

7.3.9  Results
• Fixed a bug that led to wrong labels for statistics instance count output if a row 

was deselected

7.3.10  Automation
• Fixed a bug that led to an error message when using “folder” shortcut expansions

such as *DF, *IF, etc in macros for text in popup windows, banners, Report or 
Output text, if the shortcut was not used at the beginning of the text

8  Changes in CURRY 8.0 from CURRY 7
This is an overview of the most significant changes and bug fixes that were made to the 
current software release compared with the last release, CURRY 7.

8.1  Highlights
• CURRY 8 is a native 64-bit application with unlimited memory access

• Redesigned user interface with new look-and-feel, reduced visual clutter, popup 
toolbars in data display area, toolbars above parameter panels

• Programmable function keys (F-keys) for quick selection of montages, filters, etc

• New head models: individualized FEM, inside sphere, precomputed BEM head 
model with option to exclude cerebellum from source analysis

• Source analysis based on Stereo-EEG is now possible

• New current density methods: LAURA, swLORETA, FOCUSS, ssLOFO

• Image Data rotation support for Segmentation Preview, Segmentation Result, 
MIP, Localize

• New grid view image data display option showing multiple axial slices 
simultaneously
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• Support for up to five image data sets; database drag-and-drop support with 
parameter persistence for up to ten image data sets

• Pial surface created together with cortex 

• New Statistics methods Maps SnPM, CDR SnPM, temporal multiple comparison 
correction

• Stand-alone Digitizer module supporting new devices (NDI Krios and Polhemus 
Patriot)

• Options to stream live data to MATLAB or via TCP/IP (NetStreaming), dedicated 
to BCI applications

• Exported data files contain a file history, documenting previous filenames and 
processing steps

8.2  Enhancements

8.2.1  User Interface
• Windows 10 look-and-feel

• Redesigned icons

• High-resolution display support

• Popup toolbars in data display areas; toolbars above parameter panels

• Touchscreen gesture support (swipe, zoom, etc)

• Selectable menu and dialog fonts

• Option to “not show again” information and warning popup windows

• Reworded text in popup dialogs so that all buttons have descriptions matching 
their actions (as opposed to generic text such as “OK”)

• Redesigned progress bar with smooth progress for nested tasks and display of 
remaining time; progress indication in Windows taskbar.

• Redesigned file dialogs with Options popup dialog; meaningful suggestions for 
file names and folders when saving files for more types of files saved; option to 
open file after saving for more types of files saved
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• Redesigned 3D View Properties dialogs, now matching the rest of the software

8.2.2  Database
• New database file format, based on Sqlite3. Legacy .mdb files still supported.

• Groups of subjects/patients: “Experiment” renamed to “Group”.

• Option to include multiple macros in a study, one of which can be executed 
automatically when opening the study; study macros can be run via right-click 
menu.

• Option to not display results when loading all results contained in a study.

8.2.3  Acquisition
• Digitizer module is now a separate module (see 2.17)

• Options to stream live data to MATLAB or via TCP/IP (NetStreaming), dedicated 
to BCI applications (including demo applications in C++ and MATLAB)

• Option to define multiple EEG groups in an amplifier configuration (useful when 
using multiple grid-, strip- or depth-electrodes)

• Option to use downsampled data for online data processing, while recorded file 
maintains original sampling rate

• Option to convert recordings into other formats (such as edf or cnt) without the 
need of the signal processing module

• Option to perform definable actions (start/stop recording, run quick impedance 
check) on definable event-codes

• Option to automatically generate definable events at a definable interval

• Option to overlay processed and unprocessed data

• Option to change the Sensor Placement in the Position Plot view (with 
background picture, if available)

• Option to define a timer to stop a recording

• Option to filter Event Log by event type

• Option to record data in compressed file format
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• Option to send single epochs to MATLAB or Functional Data

• Video Pan/Tilt/Zoom controls for Vivotek cameras

8.2.4  EEG and MEG Data Import
• New simplified format for functional data parameter files. Legacy .dap / .rs3 

format still supported.

8.2.5  Signal Processing
• The data processing pipeline can be customized regarding processing steps 

(Rereferencing, Baseline Correction, Filtering, Template Matching, Artifact 
Reduction, Miscellaneous) and their order.

• Up to five applications of each processing module are possible.

• Processing scopes for ERP, Epilepsy, and Curry 7 legacy.

• Template matching with automated time range selection (-100 … +400ms) around
single timepoint.

• Events and epochs can now be analyzed for the same criteria (Voltage, Noise, 
SNR) in order to exclude/reject outliers.

• Dipole clusters can be computed by scanning selected events or epochs.

• Possibility to perform a data interpolation for standardized 10/20 electrode 
positions. 

• Continuous wavelet transform for time-frequency analysis, supporting Morlet, 
Mexican Hat and Paul wavelets.

• Exported data files contain a file history, documenting previous filenames and 
processing steps.

• Also export video when exporting a data file.

8.2.6  Maps
• Statistics p-Values are now displayed in logarithmic scale; improved display of 

insignificant segments in hatched style

• Option to use equal scale even if not in butterfly plot mode
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• Gray backdrop if SNR in PCA/ICA plots is below 1

8.2.7  Source Analysis
• New head models:

◦ individualized FEM (for Scalp-EEG and Stereo-EEG) based on tetrahedra or 
cubes, with support for anisotropic skull

◦ inside sphere (for depth electrode support)

◦ precomputed BEM head model allowing to exclude cerebellum from source 
analysis

• Option to perform source analysis for Stereo-EEG

• Option to create a BEM or FEM head model directly from the head model 
dropdown

• Option to exclude a certain volume-of-interest defined by image data markers or 
overlays from the allowed source space

• New default brain-to-skull conductivity ratio of 25 (instead of 80); display of brain-
to-skull conductivity ratio in Head Model panel

• Option to adjust scaling of standard surfaces and precomputed head models 
based on electrode locations

• Option to start dipole clustering directly from Fit parameters

• Logging of achieved and expected deviations (goodness-of-fit)

• New current density methods:

◦ LAURA

◦ swLORETA

◦ FOCUSS

◦ ssLOFO

• New CDR dipole (“virtual electrode”, “probe”) options

◦ regional CDR dipole

◦ mirrored CDR dipole
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◦ CDR dipole representing a volume-of-interest defined by image data 
segmentation result or markers

• New button to initialize coherence clipping based on display clipping used for 
current density results

8.2.8  Image Data Import
• Support for additional image data file formats

◦ Freesurfer .mgh

◦ Freesurfer compressed .mgz

◦ Nifti compressed .nii.gz

◦ JPEG 2000-encoded DICOM

• Improved built-in image datasets

◦ higher-resolution standard dataset based on ICBM-152

◦ new pediatric dataset for age range 0-5.

• New field strength UI on File Format page

• Autodetection of real-world data range from image data files

• Threshold page including threshold estimation is only offered if modality is MRI

• Histogram correction (based on ITK N4 algorithm) for improving intensity 
homogeneity; automatically suggested if field strength is larger than 2.5T

• Option to import landmarks from first image data set

8.2.9  Image Processing
• Pial surface is now created along with cortex and can be activated for display in 

3D View cortex properties.

• Rotation, reslice support and Localize location display for

◦ Segmentation Preview

◦ Segmentation Result

◦ Maximum Intensity Projection (MIP)
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• New grid view display option showing multiple axial slices simultaneously

• Option to display up to five image data sets simultaneously

• Parameter persistence for up to ten image data sets when reordering them in 
database

• Improved display of DTI fractional anisotropy data with fiber orientation lines 
overlaid onto orthogonal views

• Option to activate “magnetic” cursor where highest intensity in vicinity is selected 
after clicking in image data. 

• New automatic marker shape mode that fills existing segmentation result with 
markers and draws a sphere when clicking outside of segmentation result

• New option for saving image data 

◦ RGB DICOM file format

◦ DICOM name, age, birthday, gender, study, series, accession number support

◦ DICOM anonymization option

◦ Save image data sets in the same coordinate space

• Option to use high-contrast symbols for dipole display, which can be selected in 
3D View dipole properties (“2D Symbol”)

• Option to superimpose more than one thresholded image data set

• Option to subtract left vs. right portions of image data.

• Option to restrict display of source results to nearby slices, which can be selected
in 3D View dipole properties (“2D Distance”)

• Option to disregard Stop markers in MIP view

• Option to keep histogram colorscale centered by pressing <Alt> when dragging 
outer handles

• Option to center zoom at cursor location

• Option to display atlas structures below cursor

• Option to display an image data scale; possibility to restrict scale display to 
functional data such as PET, SPECT, fMRI and to axial slices only
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• Adjustable cursor size and line width including “auto” mode

• Color scale support for head model display and dipole clusters (color by epoch 
type)

• User interface for histogram color scale limits

• New “PAN tilted” reslice option which offers the same angulation as used in 3D 
View.

• BEM/FEM geometry panel now allows to create FEM head models for use with 
Scalp-EEG and Stereo-EEG; skull anisotropy support; display of brain-to-skull 
conductivity ratio 

• New menu entries to create Voxel Mesh in raw image data resolution

• New menu entries to create brain mask, where different algorithms are used for 
MRI and CT data

• Display of real-world intensities in image data tooltips and on scale

• Persistence of image data save and display options across multiple simultaneous 
image data sets

8.2.10  3D View
• Updated 3D engine (Direct X11) for better and faster hardware support

• New layout options with four, six, and nine views

• Option to create movie file where the cut plane changes position

• Option to control behavior of “Rotate Eternal” via a popup dialog: normal, slow, 
advance display time as rotation progresses

• Support for RGB image data in cutplanes

• Improved standard surfaces: skin, skull, brain, cortex

• Option to display 3D Talairach grid

• Option to display waveform information for selected sensors and dipoles

8.2.11  Localize
• New layout options with large rotatable MIP
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• Multi-selection support in location list and change locations panel

• Option to adjust Localize symbol shape 

• Option to remove all locations outside of active head model

• Support for individual colors for Localize locations

• Support for defining individual EEG channel groups for Localize locations

• Support for additional file formats

◦ column-based free-format ASCII file support

◦ Elekta .dip file support

◦ normals and strengths from plain text files

• New “Action Potential” waveform for simulation

• Option to create Stereo-EEG depth/needle electrodes in Grid geometry panel

• Option to change location labels based on current EEG channel labels

• Option to load only labels from an exiting file

• Option to create normals based on locations of nearest neighbors

• Improved “Change Sensor Locations” functionality with less requirements 
regarding existing landmarks and affecting active channel groups only

8.2.12  Results
• New Statistics methods

◦ Maps SnPM (calculates significances per sensor)

◦ CDR SnPM (calculates significances per source location)

◦ Difference test for single epoch/condition type

• New Statistics options

◦ suggestion to activate “Use all selected epochs” if applicable

◦ temporal multiple comparison correction

◦ collapse (average) samples
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◦ auto-adjust number of randomizations

◦ calculate statistics for shifted latencies per condition

◦ exclude an epoch type or condition in statistics (applies if more than two are 
available)

◦ auto-create group and condition labels based on grid data

◦ resample source locations to new geometry

◦ include number of epochs in output

◦ statistics text output is now stored with Statistics results and saved to result 
files

• Improved result tree display

◦ Multi-selection support

◦ New Load/Delete/Save/Delete File options when right-clicking category in 
Results tree

• Improved Kept Results

◦ New automatic replace and append modes, accessible from Source 
Reconstruction toolbar

◦ Menu option to change dipole size to Uni when keeping or appending to 
results

• Option to export CDR and Scan results in DICOM format

• Option to export triangle meshes (including source results) in STL format for 3D 
printing

• Option to export source results and lead field as EEG/MEG data file

• New Freesurfer RAS coordinate system; option to import Freesurfer triangle 
meshes (.asc and binary formats)

• Option to not transform coordinate system when loading results (assuming 
locations in result file are valid for currently selected coordinate system)
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8.2.13  Workflow
• Scope support. Scopes are sets of factory defaults for certain application areas. 

Epilepsy, ERP, and Curry 7 scopes are provided; custom scopes can be created.

8.2.14  Automation
• Support for macros in sub-folders

• New macro language features (* example macros are available)

◦ conditional branches* 

◦ calling sub-macros* 

◦ loops*

◦ labeled jumps*

◦ show a banner and read banner text

◦ exit (end macro execution)*

◦ Option to auto-proceed if popup dialogs aren’t acknowledged

◦ shortcut *LL expands to current Localize label

◦ shortcut support for popup, Report, and Output window texts

• Option to resume macro after opening derived study from within macro

• Option to start macro opened from arbitrary location as well as study macros in 
single-step mode

8.2.15  Report
• Macro support for Report interactions

• Option to paste description to Report for all results

8.2.16  Digitizer
• Stand-alone Digitizer module (can be combined with Acquisition-, Functional 

Data- or Localize Module)

• Added Polhemus Patriot support

Doc 6509 Rev G Page 90 of 94



COMPUMEDICS USA, INC.
Title: CURRY 8.0.6 Release Notes
Document Number: 6509 Revision: G
Revised By: JK Rev Date: 11/16/20
Written By: MXW Original Release: 07/20/16
Procedure Format 3090 Rev F

• Support for point-cloud files created with NDI Krios digitizer

• Option to estimate electrode positions to speed up the digitization process

8.2.17  Miscellaneous
• Curry 8 is a native 64-bit application with unlimited memory access. On 32-bit 

versions of Windows, a 32-bit version of Curry is installed

• Option to import existing CURRY 7 settings after installation

• Restructured Edit > Options windows

◦ Option to delete to recycle bin

◦ Option to adjust fonts and to limit font size

◦ Option to specify hardcopy height while preserving aspect ratio

◦ Option to specify network dongle release time after period of inactivity

◦ New visual styles with on-the-fly switching between styles

◦ New pages: Settings, User Interface, Function Keys, Acquisition

• If necessary for changes to become effective, restarting Curry is offered

• Option to restore last open study after recovering from a crash

• Option to not send installation/upgrade/downgrade notification email

• Option to disable auto-scrolling in Output window

• New bright colors and color scales; automatic colors names support for user-
defined colors

• Compressed file format (lossless, data files are ca. 30% smaller)

• Programmable function keys (F-keys) for quick selection of montages, filters, etc

• Montage editor always shows an empty trace at the end of the traces list, for 
easier editing

• Option to display multiple video windows

• Improved visibility of the waveform scale, including the option to change its 
position
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• Option to display smooth waveforms and contour maps

• CURRY 8 Launcher application with advanced launch options

9  Known Issues
These are the known issues with the current release:

• An additional component may need to be installed in order to correctly read 
events from Profusion data files. If this is the case, download 
https://www.microsoft.com/en-us/download/details.aspx?id=54920 
and install AccessDatabaseEngine_X64.exe only.

10  Recommendation for Users in the Midst of a 
Study

If you are in the midst of a study and consider upgrading from CURRY 8 to CURRY 
8.0.5, you are advised to do so, unless your study involves source analysis and no re-
referencing has been used for EEG.

11  Installation / Upgrade
CURRY 8.0.5 is an update to CURRY 8.0. It requires the existence of CURRY 8 
software. 

12  Operating System
CURRY 8 is designed for use on Microsoft Windows 7 or later, 32 or 64-bit and has 
been extensively tested on Windows 7 32-bit, Windows 7 64-bit, and Windows 10 64-bit.
Microsoft Windows Vista or earlier as well as Windows Server operating systems are not
supported.

13  Contact and Support Information 
A procedure for obtaining support, reporting problems, or requesting features for this 
software release:
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13.1  Obtaining Support
Send an e-mail to curry  8  help@neuroscan.com  . This can be done via 

• Help > Send E-mail to Helpdesk

13.2  Reporting Problems

13.2.1  Curry Produces a Warning
If you are suspicious about a certain warning (error message):

1. Edit > Options > Troubleshooting > Enable Debug Mode 

2. Reproduce the error message as straightforward as possible

3. In Output, right-click and select Open in Editor

4. Save the log file and mail its contents to curry  8  help@neuroscan.com    

13.2.2  Curry Crashes
1. Edit > Options > Troubleshooting > Enable Debug Mode 

2. In Output, right-click and select Open File Location

3. An Explorer window opens

4. Reproduce the crash as straightforward as possible

5. In the Explorer window just opened, locate the most recent log file and e-mail it to
curry  8  help@neuroscan.com  

13.3  Requesting Features
Send an e-mail to curry  8  help@neuroscan.com  . This can be done via 

• Help > Send E-mail to Helpdesk
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14  Document History
Revision Date Author Description of Changes

A 07/20/16 MXW Initial Revision

B 01/12/17 JK Curry 8.0.1 release

C 07/14/17 RT Curry 8.0.2 release

D 04/12/18 JK Curry 8.0.3 release

E 12/19/18 JK Curry 8.0.4 release

F 09/17/19 JK Curry 8.0.5 release

G 11/16/20 JK Curry 8.0.6 release
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